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FreeHand 1-13 آشنايي با فرمت‌هاي قابل ورود به نرم‌افزار
در برنام��ه FreeHand، مي‌تواني��د فايل‌هايي با فرمت‌هاي برداري )Vector( و پيكس��لي 
)Bitmap( را به س��ند وارد )Import( کنيد. مهم‌ترين فرمت فايل‌هاي Import ش��ده عبارت 

است از:
، ش��امل عناصر ب��رداري، متن‌ها، لايه‌ها و  	 Macromedia Fireworks PNGفايل‌ه��اي

جلوه‌هايي است که در FreeHand ويرايش مي‌شود.
، محتواي گرافيکي -   برداري  	CorelDRAW و Illustrator فايل‌هاي گرافيکي برداري در

آن‌ها همانند مسيرها قابل ويرايش‌ هستند.
فايل‌هاي PSD برنامه Adobe Photoshop، هنگامي که Import	 مي‌ش��وند به صورت 

تصوير تخت و غيرقابل ويرايش هستند.
 	QuarkXPress و Adobe PageMaker ،Photoshop که در برنامه‌ه��اي EPS فايل‌هاي

ايجاد شده‌اند.
فايل‌هاي TGA ،TIFF ،PSD ،GIF ،JPEG و BMP	 که با همان قالب و فرمت اصلي در 

سند Import ،FreeHand مي‌شوند.
فايل‌هاي ديگر RTF وASCII نمونه‌هايي از آن‌ها هستند.	

)Bitmap( 2-13 وارد كردن تصوير طرح بيتي
براي وارد كردن يك كار هنري از نوع طرح بيتي )Bitmap( به FreeHand روش‌هاي زير 

را بهك‌اربريد:
1- همان‌طوركه قبلًا در واحد كار 3 با‌ فرمان Import آش��نا ش��ديد براي وارد كردن يك 

تصوير به برنامه FreeHand از فرمانFile→Import  استفاده مي‌شود.
2- از طريق كپي كردن تصوير و چس��باندن )Paste( مي‌توانيد فايل تصويري موردنظر را 

به برنامه FreeHand وارد كنيد.

 نكته: در هنگام ارسال يا انتقال فايل FreeHand، بايد تصوير وارد شده را به همراه 
آن ارسال كرد.
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ويرايش تصاوير وارد شده
تغيير اندازه تصوير: با استفاده از ابزار Pointer تصوير را انتخاب كرده سپس دستگيره‌هاي 
كنترلي را در جهت موردنظر درگ كنيد. توجه داشته باشيد كه براي حفظ تناسب‌‌هاي افقي 

و عمودي كليد Shift را نگه داريد.

شکل 1-13 نمايش دستگيره‌ها براي تغيير اندازه

 Object تغيير اندازه با استفاده از پنل
1- مي‌توانيد درصدي را در كادر متني x و y براي تغيير اندازه تصوير وارد كنيد )ش��كل 

.)13-2
2- ب��ا وارد ك��ردن مقداري در ك‌ادر متن��ي w )عرض( و h )ارتفاع( ان��دازه تصوير تغيير 

ميك‌ند )شكل 13-2(.

Object شکل 2-13 تغيير اندازه با پنل

تغيير شكل تصاوير Bitmap: براي تغيير شكل تصوير به صورت زير عمل كنيد:
1- روي تصوير وارد‌ شده دابلك‌ليك كنيد.

2- از دستگيره‌هاي ك‌نترلي يا ابزارهاي تغيير شكل جعبه ابزار Tools براي مورب كردن، 
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چرخش، تغيير مقياس و انعكاس تصوير استفاده نماييد.
 BMP به‌ ش��ما امكان مي‌دهد ك‌ه رنگ تصاوير FreeHand :Bitmap تغيير رنگ تصاوير

و Tiff سياه و سفيد يا خاكستري را تغييردهيد.
1- يك تصوير سياه و سفيد يا خاكستري‌ را انتخاب‌ نماييد.

2- نمونه رنگ را از پنل Mixer به سمت‌ تصوير بكشيد ‌)شكل 13-3(.

 

شکل 3-13 تغيير رنگ تصوير خاكستري

 ي��ا نمون��ه رنگ را از پن��ل Mixer به س��مت كادر رنگ در پن��ل Object درگ كنيد
)شكل 13-4(.

Object شکل 4-13 تغييررنگ تصوير خاكستري از طريق پنل

تمرين 1: يك تصوير دلخواه با فرمت jpg را وارد برنامه FreeHand كنيد. س��پس 
عمليات زير را روي آن انجام دهيد.

1- با استفاده از پنل Object اندازه آن را دو‌ برابر كنيد.
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2- ي��ك كپ��ي از تصوي��ر را 180 درجه بچرخانيد و به‌نحوي آن را ق��رار دهيد كه گويي 
انعكاس تصوير در آب است.

Optimize In Fireworks 3-13 كار با فرمان

 Bitmap براي ويرايش تصاوير Fireworks به ش��ما امكان مي‌دهد تا از نرم‌افزار FreeHand

استفاده كنيد. 
با اس��تفاده از برنامه Fireworks مي‌توانيد حجم تصاوير با كيفيت بالا را كم كرده و براي 

انتشار در وب آماده سازيد.

 توجه: Fireworks فايل‌ها را به اس��ناد RGB تبديل ميك‌ند، بنابراين اگر قرار است 

تصويري به عنوان سند CMYK باقي بماند از برنامه Fireworks براي ويرايش تصاوير استفاده 
نكنيد.

دو نوع فايل Fireworks وجود دارد كه مي‌توانند به FreeHand وارد شوند:
1- فايل‌هاي اوليه Fireworks PNG، انواع خاصي از تصاوير پيكس��لي )Bitmap( هس��تند 
كه ش��امل لايه‌ها و اشياي جداگانه مي‌باشند. منظور اين است كه هر شئ به يك آيتم مجزا 
در   FreeHand تبديل مي‌ش��ود كه خط دور، زمينه يا جلوه‌اعمال‌ش��ده به ش��ئ را مي‌توان 

تغيير داد. 
2- فايل‌ه��اي صادرش��ده Fireworks فايل‌هاي TIFF ،JPG ،GIFيا PNG هس��تند كه در
FreeHand به صورت يك تصوير Bitmap قرار مي‌گيرند، يعني نمي‌توانيد اش��ياي مجزا را در 

FreeHand ويرايش كنيد.

1-3-13 فرمت‌هاي تصاوير در وب

فرمت‌های تصويری در اصل روش‌هاي اس��تاندارد برای ذخيره‌س��ازی داده‌های تصويري 
هس��تند. فايل‌هاي گرافيکي Bitmap که فرم��ت JPEG،GIF  و PNG دارند، معمولاً براي وب 
جهان‌گستر استفاده مي‌شوند. چون مي‌توانيد آن‌ها را بسيار فشرده کنيد تا سريع‌تر در اينترنت 

انتقال يافته و جا‌به‌جا شوند؛ به همين دليل توسط اکثر مرورگرها پشتيباني مي‌شوند.

 نكته: فرمت GIF و JPEG و PNG پشتيباني مي‌شوند.
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اس��ت ک��ه ابت��دا آن‌ه��ا را  ب��راي ايج��اد تصويره��ا در وب، بهتري��ن کار اي��ن 	
بهينه‌سازي1کنيد.

بهينه‌س��ازي تصويره��اي وب مس��تلزم انتخ��اب فرمتي اس��ت که بهتري��ن رنگ و  	
فشرده‌س��ازي را براي تصوير داشته باشد و حداکثر کيفيت آن را تا حد امکان حفظ 

کند.
پس از بهينه‌سازي تصوير آنچه اهميت دارد پيش‌نمايش آن‌ها در مرورگرهاي وب و  	

اطمينان از نمايش دقيق آن‌هاست.
همان‌طور كه گفته ش��د با اس��تفاده از برنامهMacromedia Fireworks 	 مي‌توانيد در 

داخل FreeHand تصويرهاي وب را ويرايش کنيد.
2-3-13 بهينه‌سازي تصويرها

شما مي‌توانيد تصاوير موجود در FreeHand را با استفاده از برنامه Fireworks بهينه‌سازي 
كنيد؛ مانند تغيير فرمت فايل كه يكي از موارد بهينه‌سازي است.

به منظور انجام بهينه‌سازي مراحل زير را انجام دهيد:
1- در سند FreeHand تصوير ‌موردنظر خود را انتخاب كنيد.
2- از منوي Edit گزينه Optimize In Fireworks را ‌برگزينيد.

3- كادر محاوره Find Source نمايان مي‌ش��ود تا مشخص كنيد كه آيا مي‌خواهيد تصوير 
 Fireworks بهينه‌س��ازي كنيد يا خير. س��پس از منوي بازشوي PNG را به صورت فايل اوليه
source files گزينه مورد نظر را انتخاب كنيد )در مورد اين گزينه‌ها در بخش 1-3-13 شرح 

داده شد(.
4- هنگامي كه فايل در كادر محاوره برنامه Fireworks باز مي‌ش��ود مي‌توانيد ويرايش��ات 

بعد را انجام دهيد.

 1- Optimize 
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شكل 5-13 زبانه  Optionsدر كادر محاوره بهينه‌سازي

ب��راي ويرايش تنظيمات بهينه‌س��ازي روي زبان��ه Options	 كلي��ك كنيد و تنظيم 
دلخواهي را تغيير دهيد )شكل 13-5(.

ب��راي ويرايش اندازه فاي��ل و تنظيم نواحي اطراف‌ تصوير صادر ش��ده، زبانه File	 را 
انتخاب كنيد سپس تنظيمات موردنظر را اعمال نماييد.

براي ويرايش تنظيمات متحرك‌سازي تصوير، زبانه Animation را كليك كنيد.	
5- پس از پايان ويرايش ‌تصوير دكمه Update را كليك كنيد.

در اين صورت تغييرات روي تصوير موجود در FreeHand نيز اعمال مي‌شود كه اصطلاحاً 
به آن Update مي‌گويند. همچنين اگر فايل اوليه PNG را انتخاب كرده باشيد تصوير به‌صورت 
 )Link( به آن متصل FreeHand ذخيره مي‌‌شود. اگر تصوير وارد شده در سند PNG فايل اوليه
ش��ده باشد ترجيحاً بايد در سند FreeHand نيز چسبانده )Embed( شود تا تغييرات روي آن 

انجام شود. همچنين فايل تصويري خارج از FreeHand نيز Update مي‌شود.
 Trace4-13تبديل تصاوير نقشه‌بيتي به برداري توسط ابزار

مي‌توانيد کارهاي هنري آماده يا اس��كن ش��ده را به سند FreeHand وارد کرده و با به‌کار 
بردن ابزارTrace  آن‌ها را به مسير تبديل كنيد. ابزار Trace مي‌تواند اشكال مختلف كار هنري 
از قبيل گرافي‌کهاي ايجاد شده در FreeHand، تصويرهاي Bitmap و متن )Text( را تشخيص 
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داده و آن‌ها را به مسيرهاي برداري تبديل كند.
هنگامي که تصاوير را براي استفاده در FreeHand، اسكن )Scan( مي‌کنيد، بهتر است که 
 )Trace( .اس��تفاده شود )dpi( بين300 تا600 نقطه در اينچ )Resolution( از درجه وضوحي
تصوير اسكن شده با کيفيتdpi  600، نقاط بسيار زيادي ايجاد مي‌کند. علاوه بر اين تصوير 

با کيفيت بالا نسبت به تصوير با کيفيت پايين به حافظه بيشتري نياز دارد.

 توجه: اگر مقدار حافظه کم باشد، تصوير با حداقل Trace( ،Resolution( مي‌شود.

Trace Tool 1-4-13 تنظيمات ابزار

هنگامي که تصويرهاي Bitmap و اش��ياء ب��رداري )Vector( را Trace مي‌کنيد؛ تنظيمات 
پيش‌ف��رض نتيجه مناس��ب را فراهم مي‌کند ب��دون اين‌که از حافظه سيس��تم بيش از حد 

استفاده کند.

 نكته: قبل از بهك‌ارگيري ابزار Trace بايد گزينه‌هاي آن را تنظيم كنيد. 

همچنين در هنگام اجراي Trace روي موضوع‌هاي گرافيکي، امکان تبديل رنگ‌ها وجود 
دارد و مي‌توانيد تعداد رنگ‌ها، مد )mode( و محدوده رنگ به‌کار رفته در اش��ياء را مش��خص 

کنيد.

 توج�ه: ب��ا خارج ش��دن از برنام��ه FreeHand ، تنظيم��ات Trace Tool در بخش 

Preferences فايل FreeHand ذخيره مي‌شود.

براي تنظيم ابزار Trace به صورت زير عمل كنيد:
روش اجرا:

1- در جعبه ابزار روي ابزار Trace دابل کليک کنيد.   
2- در کادر محاوره Trace Tool از قسمت Color mode مد رنگ را تعيين کنيد.

تعداد رنگ را که از 2 تا 256	 اس��ت، مش��خص کنيد؛ رنگ‌هاي اضافي به رنگ‌هاي 
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نزد‌کيتر تبديل مي‌شوند.
 : 	Colors( را براي تعيين رنگ تصوير نهاي��ي انتخاب كنيدGrays  ي��ا Colors گزين��ه

رنگي - Grays: خاكستري(.
 	Trace را ب��راي تعيين مد رنگ تصوير نهاي��ي پس از عمل CMYK يا RGB گزين��ه

برگزينيد.

Trace شکل 6-13كادر محاوره تنظيم ابزار

 نكته: براي اضافه کردن رنگ موارد Import ش��ده يا Trace ش��ده به ليست پنل 
 Eyedropper را اج��را کرده يا از ابزار Xtras→Colors→Name All Colors  مس��ير ،Swatches

استفاده کنيد.

3- مقدار درجه وضوحResolution( ( را تعيين کنيد.
انتخاب گزينه High س��بب نمايش جزييات بيشتر تصوير مي‌شود. اين نوع Trace	 با 

سرعت پايين و مصرف زياد حافظه اجرا مي‌شود. 
انتخاب گزينه Low سبب نمايش کمترين جزييات تصوير مي‌شود. اين نوع Trace	 با 

سرعت بالا و مصرف کم حافظه اجرا مي‌شود. 
گزينه  ‌Normalحالتي بين دو گزينه High و Low  را ايجاد مي‌کند.	

4- ي��ک م��ورد از گزينه‌ه��اي Trace layers را ک��هForeground  )ردياب��ي لايه‌ه��اي 
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پيش‌زمينه(،All )همه لايه‌هاي س��ند( يا Background )لايه‌هاي پس‌زمينه( است؛ برگزينيد. 
در برنامه FreeHand همه مسيرها در لايه‌هاي مشخص شدهTrace  مي‌شوند.

5- گزينه Path conversion را براي مش��خص کردن اين که چه‌طور مس��يرها رديابي يا 
Trace مي‌شوند، تنظيم کنيد.

، لبه‌هاي بيروني تصوير را براي ايجاد مس��يرهاي پرش��ده و  	Outline انتخ��اب‌ گزينه
بسته رديابي مي‌کند.

انتخاب‌ گزينه Centerline، مرکز خط‌هاي دور تصوير گرافيکي را Trace ميك‌ند.	
، س��بب ترکيب خط دور و مرکزي مي‌ش��ود. در  	Centerline/Outline انتخاب‌ گزينه

بخشOpen Paths Below  مقداري بين 2 تا 10 وارد کنيد.
انتخاب‌ گزينه Outer Edge، فقط خطوط خارجي تصوير را رديابي ميك‌ند.	

6- ‌مقدار Trace conformity يا تنظيم حساسيت ابزار Trace، براي مشخص کردن ميزان 
نزدکيي و ش��باهت مسيرهاي Trace ش��ده به مدل اوليه، بهك‌ار مي‌روند. عددها مي‌توانند از 
صفر )ش��باهت کمتر با نقطه‌هاي کمتر( تا 10 )شباهت بيش��تر با نقطه‌هاي‌ بيشتر( انتخاب 

شوند.
7- ع��دد Noise tolerance ي ��ا دكمه لغزن��ده آن براي حذف پيكس��ل‌هاي اضافه )نظير 

گردوغبار در اسكن( بهك‌ار مي‌رود. مقدار آن بين 0 تا 20 است.
8- مق��دار Wand color tolerance به ش��ما امكان مي‌دهد مح��دوده رنگ‌هايي را تنظيم 
كني��د كه ابزار Trace به عنوان رنگ نهايي تش��خيص مي‌دهد. مح��دوده آن از صفر )رنگ‌ها 
به محدوده رنگ انتخابي نزد‌کيتر و ش��بيه‌تر و محدوده انتخاب کوچ‌کتر( تا  255 )ميزان 

شباهت رنگ‌ها کمتر و محدوده انتخاب گسترده‌تر( است.
9- روي دکمه OK کليک کنيد.

تمرين 2: در تصوير برگ شکل 7-13 لبه‌هاي ناحيه سبز رنگ را Trace کنيد.
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شکل 13-7

1- روي ابزار Trace Tool کليک ‌کنيد.
2- در تنظيمات‌ Trace Tool مقدار Tolerance را 223 و س��اير تنظيم‌ها را طبق ش��کل 

7-13 تعيين کنيد.
3- در سند ‌روي ناحيه سبز رنگ، کليک کنيد.

4- ب��ا کلي‌ک روي ناحيه انتخاب ش��ده و انتخاب گزين��ه Convert Selection Edge، فقط 
لبه‌هاي ناحيه انتخاب شده راTrace  کنيد. 

5- تصوير Trace ‌ش��ده روي ش��کل اصلي ايجاد مي‌ش��ود )ش��کل 8-13( که با توجه به 
انتخاب رنگ سياه قبل از اعمال Trace، رنگ آن سياه شده است.

Trace شکل 8-13 نتيجه عمل

تمرين 3: لبه‌هاي شکل 9-13 را Trace کنيد. )توجه داشته باشيد كه اين فايل 
در پوشه Samples برنامه فتوشاپ قرار دارد.(
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شکل 13-9

)Bitmap( 5-13 تبديل تصوير برداري به طرح بيتي
براي تبديل سريع تصويرهاي برداري به تصوير Bitmap  فرمانConvert to Image  به‌کار 
 TIFF مي‌شوند و شئ تبديل شده به صورت کي فايل Rasterize ًمي‌رود و تصويرها اصطلاحا

در درون سند FreeHand  قرار مي‌گيرد.

 توجه: تصوير Bitmap ايجاد ش��ده جايگزين تصوير اوليه و اصلي که برداري است، 

مي‌ش��ود. اگر مي‌خواهيد تصوير اصلي را نگه داريد، ابتدا کي کپي از آن ايجاد کرده و عمل 
تبديل را روي کپي آن انجام دهيد.

اگر حجم فايل تصويري زياد باش��د يا تصوير پيچيده باش��د، پيامي مبني بر ايجاد خطا 
 Export ،Bitmap در تبديل ظاهر مي‌ش��ود. بهتر اس��ت که اين تصويرهاي پيچيده به فرمت

شوند.
 Bitmap 1-5-13 مراحل تبديل تصوير برداري به

1- اشياء يا تصاوير برداري موردنظر را انتخاب كنيد.
 Convert to Image را اجرا کنيد تا کادر محاوره Modify→Convert to Image 2- فرم��ان

آشکار شود.
3- در کادر مح��اوره Convert to Image مق��دار  Resolution)کيفيت يا وضوح تصوير( را 

تنظيم کنيد
dpi 72	 براي کارهاي هنري تحت وب به‌کار مي‌رود.

 144dpi	 به عنوان پيش‌نويس چاپ به‌کار مي‌رود.

300dpi براي کار نهايي شده و آماده چاپ به‌کار مي‌رود.	
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Resolution شکل 10-13 منو بازشوي

4- براي نرمي خط‌ها و هموار ش��دن لبه‌هاي دور تصوير، گزينه Anti-aliasing را تنظيم 
کنيد. عدد بالاتر سبب نرمي بيشتر مي‌شود.

5- روي دکمه OK کليک کنيد. 

 نكت�ه: مي‌تواني��د همزمان بيش از کي تصوير ب��رداري را انتخاب کرده و ب��ه Bitmap تبديل 
کنيد.

 300 dpi مثال 1: يك تصويرِ برداري دلخواه مانند شكل 11-13 را با درجه وضوح
و انتخاب عدد 4 براي گزينه Anti-aliasing به تصوير Bitmap تبديل كنيد.

1- شکل 10-13 را انتخاب ‌کنيد.

شکل 11-13 تصوير برداري

2- مسير Modify→Convert to Image را اجرا ‌کنيد.
 300dpi کيفيت تصوير( را( Resolution مق��دار Convert to Image 3- در ‌کادر مح��اوره

انتخاب کنيد.
4- عدد 4 را براي Anti-aliasing تنظيم کنيد.‌

همان‌طور که با مقايس��ه نوار Info در ‌ش��کل‌هاي 11-13و 12-13 مش��اهده مي‌کنيد، 
ش��ئ تبديل ش��ده به صورت کي فايل TIFF درون س��ند FreeHand  قرار مي‌گيرد )ش��کل 

.)13-12
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شکل 12-13تصوير TIFFكهEmbedded  شده

تمري�ن 4: تصوي��ر برداري زير )قس��متي از يك فايل در پوش��ه Sample برنامه 
FreeHand است( را به پيكسلي يا Bitmap تبديل كنيد.

شکل 13-13
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واژه‌نامه 
Anti-aliasingضدناهمواري، روشي براي هموار نمودن خطوط ناهموار يا دندانه‌دار

Conversionتغيير، تبديل

Draftپيش‌نويس، چر‌کنويس

Embeddedدر درون قرارگرفتن، چسباندن

Lossyپراتلاف

Losslessبدون اتلاف

Noiseاختلال،خش

Optionاختيار

Sourceمنبع، اصلي، اوليه

Outlineخط دور

Rasterizeتبديل

Traceرسم کردن، کشيدن

Vectorبرداري

خلاصه مطالب
( و پيكس��لي  	Vector( مي‌توانيد فايل‌هايي با فرمت‌هاي برداري ،FreeHand در برنامه

)Bitmap( را به سند وارد )Import( کنيد.
مي‌توانيد تصاوير وارد شده در FreeHand را با استفاده از Fireworks ويرايش كنيد.	

 	FreeHand مي‌توانيد تصاوير موجود در Optimize In Fireworks با استفاده از فرمان
را با استفاده از برنامه Fireworks بهينه‌‌سازي كنيد.

اب��زارTrace  مي‌تواند گرافي‌کهاي ايجاد ش��ده در FreeHand، تصويرهاي Bitmap	 و 
متن )Text( را تشخيص داده و آن‌ها را به مسيرهاي برداري تبديل كند.

 	 Convert to Imageفرم��ان Bitmap براي‌تبديل‌س��ريع تصويرهاي ب��رداري به تصوير
به‌کارمي‌رود.
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آزمون نظري
درستي يا نادرستي گزينه هاي زير را تعيين کنيد.

1- فايل‌هايMacromedia Fireworks PNG ، در FreeHand ويرايش مي‌شود.
2- فايل‌هاي گرافيکي برداري CorelDRAW همانند مسيرها غيرقابل ويرايش هستند.

3- فايل‌ه��اي JPEG ،TIFF ،TGA ي��ا BMP با همان قالب و فرمت اصلي‌ش��ان در س��ند 
Import ،FreeHand مي‌شوند.

4- فايلSWF در FreeHand قابل ويرايش است.
معادل گزينه هاي سمت‌راست را از ستون سمت‌چپ انتخاب کرده و مقابل هر عبارت بنويسيد.

5- براي وارد كردن تصاوير طرح بيتي به سند FreeHand از اين فرمان استفاده مي‌شود
GIF                                                                                                        .
Lossy                                    .بهك‌ار مي‌رود Bitmap 6- اين نرم‌افزار براي ويرايش تصاوير
Import                 .7- روش فشرده‌سازي فايل‌ها كه داده‌هاي اوليه بازيابي نمي‌شوند
Fireworks                             .8- عمق رنگ در اين نوع فايل حداكثر 8 بيت است

گزينه صحيح را انتخاب کنيد.

9- براي صادر كردن تصاوير در وب كدام فرمت شفافيت را حفظ نميك‌ند؟
Tiff -د                 Jpeg -ج              Gif -ب          PNG -الف

10- كدام يك از موارد زير به طور اتوماتيك فايل اوليه PNG را باز ميك‌ند؟
Never Use Source PNG -ب              	 Always Use Source PNG -الف

Use This File -د                            Ask When Launching -ج
11- فرمان Optimize in Fireworks چه عملي انجام مي‌دهد؟

الف- حذف فايل‌هاي غيرضروري 	           ب- افزودن طراحي به تصوير
FreeHand فايل تصوير به Link -د ج- تغيير اندازه و تغيير فرمت فايل	

12- با استفاده از ابزار ................... مي‌توان تصاوير Bitmap را برداري كرد.
Trace -د           Optimize -ج           Lasso -ب            Pointer -الف

13- دكم��ه لغزنده Trace conformity در كادر مح��اوره Trace Tool به چه‌منظور بهك‌ار 
مي‌رود؟
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الف- سبب ترکيب خط دور و مرکزي مي‌شود.
ب- ميزان شباهت مسيرهاي Trace شده به مدل اوليه را تعيين ميك‌ند.

ج- براي حذف پيكسل‌هاي اضافه تصاوير بهك‌ار مي‌رود.
د- براي تنظيم محدوده رنگ‌ها استفاده مي‌شود. 

در جاي خالي عبارت مناسب را بنويسيد.

14- فرم��ان .................... ب��راي تبدي��ل تصوير ب��رداري به طرح بيت��ي )Bitmap( بهك‌ار 
مي‌رود.

15- گزينه Anti-aliasing براي تنظيم ......................... استفاده مي‌شود. 
16- ب��راي ك��م كردن ناحيه انتخاب با اب��زار Trace همزمان با كليك كلي��د ....... را نگه 

داريد.
17- در هنگام بهينه‌سازي پس از پايان ويرايش تصوير دكمه ................ را كليك كنيد. 

به سؤالات زير پاسخ تشريحی دهيد.

18- كدامي‌ك از انواع درجه وضوح سبب رديابي با سرعت بالا مي‌شود؟
19- اگر ميزان حافظه كم باشد تصوير چگونه Trace مي‌شود؟

20- مزيت فرمت GIF را با فرمت JPEG مقايسه كنيد؟
آزمون عملي

1- فاي��ل تصويري از ن��وع طرح بيتي وارد FreeHand كنيد س��پس عمليات زير را انجام 
دهيد:

اندازه تصوير را دو برابر كنيد. 	
با استفاده از پنل Object	 عرض تصوير را به ميزان دلخواه كاهش دهيد.

تصوير را 90	 درجه بچرخانيد.
انعكاس عمودي تصوير را در كنار آن قرار دهيد. 	

 Photoshop رنگي دلخ��واه را در برنام��هBitmap  ي��ك فايل تصوي��ري )mode( 2- م��د
خاكستري كرده سپس از طريق Copy-Paste آن را وارد FreeHand كنيد. سپس توسط پنل 

Mixer آن را به رنگ سبز تغيير دهيد.

3- طرح زير را رسم كرده سپس با برنامه Fireworks آن را به نحوي ويرايش كنيد كه در 
هنگام باز شدن پيغامي را نمايش دهد. ويرايش مربوط به تغيير اندازه فايل باشد.
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4- قس��متي از تصوير مورد نظر از پوش��ه My Pictures سيس��تم خود را با ابزار مناسب و 
تنظيمات زير رديابي كنيد.

جزييات تصوير بيشتر ديده شود. 	
حساسيت ابزار رديابي را 7	 در نظر بگيريد.

محدوده رنگ تنظيم شده به نحوي باشد كه رنگ‌هاي انتخابي نزديك‌تر قرار گيرد. 	
5- ي��ك تصوير ب��رداري را ب��ه FreeHand وارد كنيد س��پس آن را ب��ه Bitmap تبديل 

نماييد.
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كليات
کيي ‌از ‌جالب‌ترين ‌امکاناتي‌که در FreeHand وجود دارد، ايجاد پويانمايي ‌و حرکت ‌اس��ت 
‌که‌ مي‌تواند در صفحه‌هاي وب و فيلم‌هاي تعاملي )Interactive( اس��تفاده شود. در اين واحد 

کار اين امکانات بررسي مي‌شود.
FreeHand 1-14 مفاهيم اوليه حرکت در

حرکت )Action(: جلوه حرکتي است که به کي موضوع داده مي‌شود.
پارامتر )Parameters(: محل و موقعيت بعدي و مقصد نهايي حرکت را مشخص مي‌کند. 

به عبارتي ديگر ارزش‌هاي موردنظر Action در اين قسمت تعيين مي‌شود.
روي�داد )Event(: رخدادهايي اس��ت كه با اعمال آن‌ها ب��ه موضوعات، حرکت موردنظر 
نمايش داده مي‌ش��ود و کاربر آن را  اجرا ميك‌ن��د، مانند Press كه رويداد کليک کردن روي 

کي موضوع است يا رويداد Over كه با حرکت ماوس روي شئ رخ مي‌دهد.
ش�ئ مبدأ )Source Object(: موضوعي که عمل کشيدن ماوس )Drag( روي آن انجام 

مي‌شود.
صفحه مقصد )Target Page(: صفحه‌اي که محل پايان يافتن Action را مشخص مي‌کند 

و عمل رها کردن ماوس )Drop( در آن انجام مي‌شود.
صفحه جاري )Current Page(: صفحه‌اي که نشانگر ماوس در آن قرار دارد.

اراي�ه )Presentation(: نمايش  Actionدر پنجره Flash Player 1 ک��ه دکمه‌هاي کنترل نمايش 
تعامل��ي )Interactive( در آن ق��رار دارد و همچنين فرمت ارايهSWF  اس��ت كه به آن ارايه نيز 

گفته مي‌شود.
فيلم تعاملي )Interactive Movie(: فيلمي که در هنگام نمايش به ازاي اجراي اعمالي 
که براي آن در نظر گرفته ش��ده يعني کنش، واکنش تعريف ش��ده توس��ط کاربر را نش��ان 

مي‌دهد. اين فيلم‌ها در صفحه‌هاي وب نيز قابل استفاده است.
مح�دوده حرکت )Action Area(: فهرس��ت زيرمجموعه م��وارد پويانمايي را به صورت 

Action script يعني زبان برنامه‌نويسي برنامه Flash 2 در دسترس قرار مي‌دهد.

فري�م يا قاب )Frame(: به هريك از تصاويري كه نمايش متوالي و س��ريع آن‌ها باعث 

Flash 1- نمايشگر فيلم
2- نرم‌افزاري براي ساخت انيميشن دو بعدي
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ايجاد فيلم يا انيميشن مي‌شود، Frame مي‌گويند كه در واقع هر قاب، بيانگر يكي از لحظات 
اجراي فيلم است.

  Action Tool 2-14 ابزار
 )drag &drop( جلوه‌هاي حرکتي را با انجام عمل کش��يدن و رها کردن Action Tool ابزار
به موضوع‌ه��ا )objects(، نمادها )Symbols( و صفحه‌ها )Pages( اعمال ميك‌ند وAction هاي 
Flash را براي موارد گفته شده در سند FreeHand در نظر مي‌گيرد و به آن‌ها نسبت مي‌دهد؛ 

به‌عنوان مثال مي‌توانيد در س��ندي دو صفحه‌اي که در صفحه اول آن کي موضوع گرافيکي 
ق��رار دارد، ي��ك Action را در نظر بگيريد که با کليک روي موضوع، صفحه دوم را ظاهر کند 

و نشان دهد.
Action 1-2-14 ايجاد

براي انتساب کي Action به شئ ]موضوع[ به ترتيب مراحل زير را اجرا کنيد:
1- روي ابزار  Action در جعبه ابزار کليک کنيد.

2- از ش��ئ موردنظر به سمت صفحه مقصد درگ کنيد بدين ترتيب خطي از شئ مزبور 
تا صفحه مقصد امتداد ميي‌ابد )شکل 14-1(.

شکل 1-14 درگ شئ مبدأ به مقصد

3- زماني که كليد ماوس را رها کنيد، صفحه جاري که برجس��ته شده، به عنوان صفحه 
 مقصد در نظر گرفته مي‌ش��ود و يك خط ‌انحنادار نشان‌ مي‌دهد كه Action ايجاد شده ‌است

)شکل 14-2(. 
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Action Tool ايجاد شده با ابزار Action 14-2 شکل

زماني که براي کي ش��ئ Action تعريف مي‌کنيد در گوش��ه پايين س��مت راس��ت آن علامتي به نام

Action Proton ظاهر مي‌شود )شکل 14-3(. 

  شکل 14-3
Action پيش‌ف��رض FreeHand ک��ه با ابزار Action Tool	 ايج��اد و به موضوع‌هاي به وجود 
آورنده حرکت، اختصاص داده مي‌ش��ود، Go To and Stop اس��ت که در ش��کل 4-14در پنل 
Navigation مش��خص ش��ده اس��ت و با فش��ردن کليد ماوس محتويات صفحه 2 را که در لايه 

Foreground قرار دارد، نشان مي‌دهد. 

Navigation با استفاده از پنل Flash هايAction شکل 4-14 دسترسي به
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 توجه: ساده‌ترين روش ايجاد Action، استفاده از ابزار Action Tool   است.

 Action 2-2-14 حذف

اگر در صفحه‌اي که ش��ئ مبدأ در آن قرار دارد، Action Proton  را با اس��تفاده از ابزار 
انتخ��اب Subselect يا Pointer درگ ك��رده و آن‌ را در فضاي خالي )فضاي چر‌کنويس( رها 

كنيد در اين صورت Action تخصيص يافته به شئ، حذف مي‌شود.
 Action 3-2-14 تغيير رفتار

1- براي تغيير رفتار پيش‌فرض ابزار Action در جعبه ابزار به صورت زير عمل کنيد:
 Action Tool دابل کليک کنيد ت��ا کادر محاوره Action روي ابزار Tools در جعب��ه اب��زار

ظاهر شود )شکل 14-5(.
2- با توجه به تغييري که مي‌خواهيد در رفتار Action ايجاد ش��ود کيي از گزينه‌هاي آن 

را برگزينيد.
4- روي دكمه OK كليك كنيد.

در شکل 6-14 کي   Action   براي کي موضوع متني )شماره صفحه موردنظر( انتخاب شده است به 
 طوري كه با کليک روي شماره صفحه که در پايين صفحه خانگي )Home Page-Index( ارايه به‌صورت 

متني درج شده، صفحه مربوط به آن با محتوياتش نشان داده مي‌شود.

Action شکل 5-14 تعيين رفتار
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شکل Action 14-6تعريف شده براي موضوع متني

تمرين 1: سه صفحه با اين مشخصات ايجاد کنيد:
 Blue 1- در صفحه اول شئ مربع با رنگ آبي در لايه‌اي به نام
 Red 2- در صفحه دوم شئ دايره با رنگ قرمز در لايه‌اي به نام

 Black 3- در صفحه سوم شئ ستاره با رنگ سياه در لايه‌اي به نام
س��پس با اس��تفاده از Action Tool ترتيبي دهيد که به محض کليک روي شئ اول، شئ 

سوم مشاهده شود و با کليک روي شئ سوم، شئ دوم نمايش يابد.
FreeHand به سند Flash Action 3-14 انتساب يک

در برنامه FreeHand مي‌توانيد، Actionهاي Flash را به طرح‌ها و ترسيم‌هاي ايجاد شده، 
نسبت دهيد و در فيلم‌هاي تعاملي از آن‌ها بهره بگيريد.

همچني��ن مي‌توانيد س��ندهاي FreeHand را که محتواي آن‌هاAction هاي Flash اس��ت 
به‌ص��ورت فايل SWF براي نماي��ش در Flash Player صادر کنيد. در فيلم تعاملي از مجموعه 
صفح��ه کليد، ماوس يا هر دوي آن‌ها براي حرکت اش��ياء و پرش به موقعيت‌ها و بخش‌هاي 
کي فيلم و اجراي تعداد بي‌ش��ماري از فعاليت‌هاي تعاملي1 اس��تفاده مي‌شود. براي انتساب 
کي Flash Action به اش��ياي ترسيمي در FreeHand، محدوده حرکت )Action Area( و پنل 

Navigation به‌‌کار گرفته مي‌شود.

1-  Interactive Actions 
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 FreeHand در Flash هاي Action 14-4
نتيجه کاربردAction هاي Flash در برنامه FreeHand به شرح زير است:

Actionتوضيحات

Go To and Stop
به کي فريم )صفحه‌اي در فيلم( پرش‌ ميك‌ند سپس پخش را متوقف مي‌نمايد به عبارتي 
توقف و تکرار صحنه )Play Back( انجام مي‌شود. بازيابي فهرست URL هاي كادر Link را 

كه در پنل Navigation است فراهم ميك‌ند.

Go To and Play.پرش ميك‌ند، سپس پخش فيلم را از همان نقطه ادامه مي‌دهد )Frame( به کي فريم

Get URL.بهك‌ار مي‌رود Navigation مربوط به پنل Link ليست شده در كادر URL براي رفتن به

Play.سبب اجرا يا نمايش فيلم متوقف شده مي‌شود

Stop.سبب توقف فيلم در حال اجرا مي‌شود

Print فريمي از فيلم مشخص شده را چاپ Flash Player کاربر مي‌تواند به صورت مستقيم در
کند.

Full Screen نمايش فيلم در حالت تمام صفحه و بزرگ‌تر از حالت معمولي انجام مي‌شود. در حالت تمام
صفحه، فيلم كل صفحه نمايش را مي‌پوشاند.

Start/Stop Drag

امكان‌پذير ميك‌ند و  اين عمل در زمان وقوع يك رويداد، درگ كليپ فيلم را در صفحه 
به  مي‌شود.  درگ  قابليت  رفتار  توقف  سبب  مي‌دهد،  رخ  متضاد  رويداد  يك  که  هنگامي 
به عنوان  را   On (press( اگر  مثال  به عنوان  متوقف ميك‌ند.  را  عبارت ديگر عمل درگ 
رويداد شروع اين Action در نظر بگيريد، به‌صورت خودکار )On )release را به‌عنوان عامل 
توقف درگ انتخاب مي‌کند. همچنين رويداد )On (over و )On (out رويدادهاي متضاد 

ديگر هستند.

  Load Movie

Unload Movie

فيلم Flash را از يك صفحه به فريم فيلم جاري بارگذاري ميك‌ند.

يك فيلم بارگذاري شده در فريم فيلم جاري را حذف ميك‌ند.

Tell Target
براي کنترل فيلم‌هايي است که با استفاده از عمل Load Movie در فيلم جاري بارگذاري 
شده‌اند. پارامترهاي اين Action به شما امكان مي‌دهند تا صفحه بارگذاري شده را تنظيم 

كنيد.
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 نكته: Action هاي Unload Movie ، Load Movie و  Tell Target در صورتي فعال 
هستند که سند حداقل دو صفحه داشته باشد.

بر  و   Tell Targetعلاوه   Load/Unload Movie    ،Print  ،Go To     هاي  Action   توجه:    در   

Parameters در  بازشو  را توسط منوي  اعمال  Action ها  رويداد مي‌تو‌انيد، چگونگي  تعيين 
پنل Navigation مشخص کنيد.

 مثال 1: در صفحه اول ش��کل 1 و در صفحه دوم ش��کل 2 را رسم کنيد؛ ترتيبي 
دهيد که با کليک  روي go ، رنگ س��بز چراغ راهنما به نشانه روشن شدن پررنگ شود و در 
 Stop چراغ راهنما در صفحه جابه‌جا ش��ده و به محض اين که روي Stop صفحه دوم با درگ

کليک کرديد، ديگر جابه‌جايي انجام نشود.
1- ابتدا کي س��ند دوصفحه‌اي مطابق ش��كل 7-14 ايجاد كنيد، س��پس شکل 1 را در 
صفحه اول و ش��کل 2 را در صفحه دوم رس��م کنيد. دقت نماييد که رنگ قرمز در ش��کل 1 
پررنگ و در شکل 2 کم‌رنگ است، رنگ زرد در هر دو شکل کيي و رنگ سبز در شکل دوم 
پر‌رنگ‌تر است. كلمه go )رنگ سبز( را در صفحه اول و كلمه Stop )رنگ قرمز( را در صفحه 

دوم بنويسيد.
 2- نوش��ته go از صفح��ه اول را انتخ��اب کرده و پن��ل Navigation را فعال کنيد. گزينه

Go To and Stop را از منوي بازشو Action برگزينيد.

3- در ليس��ت بازش��وي Page2 ،Parameters را انتخاب و رويداد )Event( را Press در نظر 
بگيريد.

4- در صفح��ه دوم کلم��ه Stop را انتخاب ک��رده و Start/Stop Drag را با در نظر گرفتن 
رويداد Press انتخاب کنيد.

5- براي‌مشاهده Action ايجاد شده مسير Window→Movie→Test را اجرا کنيد.
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شکل 7-14 چراغ راهنمايي

5-14 آزمايش فيلم
بعد از ايجاد يك انيميشن مي‌خواهيد نحوه اجراي آن را مشاهده كنيد، براي اين منظور 

يكي از روش‌هاي زير را برگزينيد:
1- فرمان Window→Movie→Test را اجرا نماييد.

2- كليد تركيبي Ctrl+Enter را بفشاريد.
3- روي دكمه Test  در نوار ابزار Controller كليك كنيد.

بدي��ن ترتي��ب FreeHand فيلم را در يك پنجره جداگانه )پنج��ره Flash Player( نمايش 
 Movie Settings دارد، در کادر SWF را که فرمت Flash مي‌دهد. همچنين مي‌توانيد فايل فيلم

ويرايش کنيد.
	Controller 1-5-14 نمايش

براي نمايش نوار ابزار Controller مسيرWindow→Toolbars→Controller را اجرا کنيد.
علاوه بر موارد گفته شده ساير امکانات Controller در شکل 8-14 مشخص شده است.

Controllerشکل 8-14 نوارابزار
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6-14 متحرک‌سازي با متن و شئ
يكي از روش‌هاي متحرك‌سازي اين است كه اشياء را طوري در لايه‌هاي آن‌ها قرار دهيد كه 
هر لايه مانند يك فريم عمل كند. براي متحرک کردن )انيميش��ن( اش��ياء بدون استفاده از بازه 
  Xtras→Animate→Release to Layers از فرم��ان Flash Player زماني و نمايش متحر‌کس��ازي در
اس��تفاده كنيد. در اين صورت اش��ياء در لايه‌ها قرار داده مي‌شوند و لايه‌ها به‌عنوان فريم در 
پويانمايي ايجاد ش��ده، عمل مي‌کنند. همچنين با اجراي اين دس��تور موضوع‌هاي گرافيکي 
گروه‌بندي ش��ده از گروه خارج ش��ده و بر اس��اس جلوه‌هاي منوي بازش��و Animate در کادر 
محاوره Release to Layers ، در لايه‌ها پخش مي‌ش��وند به طوري كه کي لايه جديد براي هر 

شئ ايجاد مي‌شود.

 توجه: براي ايجاد سريع کي پويانمايي از فرمان Release to Layers استفادهك  نيد.

1-6-14 ايجاد متحر‌كسازي با استفاده از لايه‌ها

1- موضوعاتي را كه مي‌خواهيد متحرك شوند، انتخاب كنيد.

 توجه:  کي شئ جاي گرفته در کي گروه مانند کي شئ مستقل و تنها عمل   مي‌کند.

 2- ب��ا اج��راي مس��ير  Window→Layer پن��ل لاي��ه را در صفح��ه، نماي��ش دهي��د 
)شکل 14-9(.

شکل 9-14 انتخاب شئ گروه‌بندي شده

3- فرمان Release to Layers را از مسير Xtras→Animate برگزينيد. در اين صورت كادر 
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محاورهRelease to Layers مطابق شكل 10-14 ظاهر مي‌شود.

شكل 14-10

 Animate 4- براي متحرک کردن ش��ئ، يكي از جلوه‌هاي پويانمايي را از منوي بازشوي
انتخاب كنيد. در اين صورت مش��خص مي‌کنيد كه اش��ياء چطور به لايه‌ها منتشر و در آن‌ها 

پخش شوند )شکل 14-11(.

 

شکل 11-14 انتخاب جلوه پويانمايي 

گزينه‌هاي منوي بازشو Animate عبارتند از:
Sequence )جلوه اس�تاندارد متحرک‌س�ازي(:	 اشياء را پشت س��رهم و متوالي در 

لايه‌هاي مجزا پخش ميك‌ند. 
با كپي كردن اشياي موجود در توالي لايه‌هاي دنبال هم،  Build )جلوه افزايش�ي(: 	

يك جلوه پشته‌اي ايجاد ميك‌ند.
به عنوان مثال اگر يك گروه متشکل از دو شئ داريد، با اعمال جلوه Build اولين شئ در 

لايه اول قرار مي‌گيرد و کپي‌‌هاي اشياي اول و دوم در لايه دوم قرار مي‌گيرند.
Drop )جلوه کاهش�ي(:	 اشياء را به تمام لايه‌ها كپي ميك‌ند ولي به‌طور متوالي يك 

شئ را از هر لايه حذف مي‌نمايد. 
به‌عنوان مثال اگر کي گروه از س��ه ش��ئ را انتخاب کنيد؛ اشياي اول، دوم و سوم در لايه 
اول قرار گرفته و ش��ئ اول و کي کپي از ش��ئ سوم در لايه دوم و کپي‌‌هاي اشياي دوم و 

سوم در لايه سوم قرار مي‌‌گيرند.
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Trail )جل�وه حرکت�ي(:	 اش��ياء را ‌در تعدادي از لايه‌هاي تعيين ش��ده كپي نموده 

و پخش ميك‌ند. اش��ياء به طور فزاينده‌اي به تعداد لايه‌هاي مش��خص ش��ده، کپي 
مي‌شوند.

5- اگر گزينه Trail را انتخاب نماييد در اين صورت با استفاده از كادر Trail by مي‌توانيد 
تعداد لايه‌هايي را كه اشياء در آن‌ها كپي مي‌شوند، تعيين كنيد. 

به عنوان مثال براي کپي هر شئ در چهار لايه، عدد 4 را براي Trail by وارد کنيد.
6- با انتخاب گزينه Reverse direction ترتيب اش��ياء، معكوس ش��ده و آن بخش از فيلم 

در جهت مخالف، متحرك مي‌شود.
7- انتخاب گزينه Use existing layers اش��ياء را در لايه‌هاي موجود پخش ميك‌ند و اين 
كار را از لايه جاري ش��روع مي‌نمايد. اگر اين گزينه را انتخاب نكنيد؛ اش��ياء را در لايه‌هاي 

جديد قرار مي‌دهد.
                         

 

Release to Layers پس از اعمال فرمان Layers شکل 12-14مشاهده انتشار اشياء در پنل

8- اگ��ر گزين��ه Use existing layers را انتخ��اب کرده‌ايد، گزينهSend to back  اش��ياء را 
برعكس ترتيب پشته‌اي پخش ميك‌ند.

9- روي دكمه OK كليك كنيد.
10- پويانماي��ي ايجادش��ده را مي‌توانيد بااس��تفاده از نواراب��زارController نمايش دهيد 

)شکل14-13(.

 نكته: بلو‌کهاي متن، Blend، اش��ياء گروه‌بندي شده و متن متصل به کي مسير 
با فرمان Release to Layers متحرک مي‌شوند.
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Flash Playerشکل 13-14نمايش پويانمايي در

مثال 2: به نوش��ته شکل 14-14 با اس��تفاده از فرمان Release to Layers، جلوه 
 

پويانمايي Drop را اعمال کنيد.
1- با فرمان Text→Convert to Path هر حرف بلوک متني را به مسير تبديل کرده، سپس 

دستور Join از منو Modify را اجرا کنيد )شکل 14-15(.

          
                               شکل 14-14	 شکل 14-15

2- گزينه Clone را از منوي Edit برگزينيد تا کي نمونه از متن تبديل شده، ايجاد  شود.
3- با انتخاب ابزار Pointer از کپي متن تبديل شده تا محلي که مي‌خواهيد متحر‌کسازي 

پايان يابد، درگ کنيد )شکل 14-16(.
4- با استفاده از کليد Shift متن اصلي و نمونه کپي ايجاد شده را انتخاب کرده و فرمان 

Xtras→Create→Blend  را روي آن اجرا کنيد )شکل 14-17(. 

      

                     شکل 16-14	                 شکل 14-17

5- با اس��تفاده از فرم��ان Release to Layers، جلوه Drop را به متن اعمال کنيد. در پنل 
 Welcome To FreeHand MX 41 لاي��ه ايجاد مي‌ش��ود که هر کدام حاوي عب��ارت ،Layers
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هستند )شکل 14-18(. 

شکل 14-18

Flash  به يک انيميشن Blend 2-6-14 تبديل
همان‌طورک��ه گفته ش��د اج��راي فرم��ان Release to Layers روي ي��ک Blend و تنظيم 

گزينه‌هاي کادرRelease to Layers، کي انيميشن Flash ايجاد ميك‌ند.
روش اجرا:

Blend -1  مورد نظر را انتخاب کنيد )شکل 14-19(.

2- با اجراي مسير Window→Layer پنل لايه را در صفحه، نمايش دهيد.
3- مسير Xtras→Animate→Release to Layers را اجرا کنيد.

برگزيني��د  را   Build گزين��ه   Animate بازش��و  من��وي  از  ش��ده  ظاه��ر  کادر  در   -4 
)شکل 14-19(.

5- گزينه Use existing layers را انتخاب کنيد.
6- در پنجره Flash Player انيميشن ايجاد شده را نمايش دهيد )شکل 14-20(.     

 

 Blend شکل 20-14 نمايش متحر‌کسازي                    Release to Layers شکل 19- 14 اجراي فرمان

Flash در نمايشگر                                                                Blend روي کي     
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 مثال3: با ايجاد کي متحر‌کسازي به‌وسيله Blend ، ترتيبي دهيد که شکل مربع 
به دايره و سپس ستاره تبديل شود.

1- ابتدا ش��کل س��مت راست 21-14 را رس��م و کي Blend از مربع به دايره طبق شکل 
سمت چپ   23-14 ايجاد كنيد. 

2- حال طبق شکل 22-14 کي Blend از دايره به ستاره ايجاد کنيد.
3- پ��س از انتخ��اب Blend موردنظر و در واقع انتخاب کل اش��ياء رس��م ش��ده، مس��ير

Xtras→Animate→Release to Layers را اجرا کنيد.

4- در کادر محاوره ظاهر ش��ده از منوي بازش��و Animate گزينه Sequence را برگزينيد 
)شکل 14-23(.

             

شکل 21-14                                                             شکل 14-22

5- گزينه Use existing layers را انتخاب کنيد.
6- در پنجره Flash Player انيميشن ايجاد شده را نمايش دهيد.

 

شکل 14-23

تمرين 2: با استفاده از Blend، متحر‌کسازي ايجاد کنيد که کلمه Photoshop را 
به FreeHand تبديل کند و جلوه حرکتي )Trail( با عدد 5 را براي آن در نظر بگيريد.

)راهنمايي: پس از نوشتن کلمه‌ها، قبل از ايجاد Blend آن‌ها را به مسير تبديل کنيد.(
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	Navigation 3-6-14 کار با پنل

همان‌طوركه قبلًا شرح داده شد با استفاده از ابزار    Action مي‌توانيد اعمال )Action( را به 
اشياي FreeHand نسبت دهيد. حال در اين‌جا مي‌خواهيم از پنل Navigation استفاده كرده 

و Actionهاي Flash را به اشياء سند FreeHand ارتباط دهيم.
براي نس��بت دادن اعمال )Action( با اس��تفاده از پنل Navigation ، مراحل بعد را انجام 

دهيد:
روش اجرا:

1- شئ يا موضوعات موردنظر را انتخاب نماييد. 
2- براي ظاهر کردن پنل Navigation از مس��ير Window→Navigation استفاده کنيد تا 

اين پنل مطابق شکل 24-14 باز شود.
3- از منوي بازشوي Action براي انتخاب يك عمل )Action( استفاده كنيد.

 Event را فعال ميك‌ند، از منوي بازش��وي )Action( 4- ب��راي انتخاب رويدادي كه عمل
استفاده نماييد )شكل 14-24( 

 Navigation شکل 24-14 پنل

 Load /Unload،Print ،Go To and Play ،Go To and Stop 5- در ص��ورت انتخاب گزين��ه
Movie يا Tell Target در منوي بازش��وي Action، از اولين منوي بازش��وي Parameters براي 

انتخاب از ليست صفحات سند جاري، استفاده كنيد. 
6- در صورت انتخاب گزينه Go To and Play ، Go To and Stop يا Print براي تعيين اين 
 Parameters كه كدام بخش از سند بايد نمايش داده شود يا چاپ شود، دومين منوي بازشوي

را به كاربريد.
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7- در ص��ورت انتخاب Tell Target براي كنترل پخ��ش فيلم ديگر، يكي از ‌Action هاي 
Stop،Go To and Stop/Play ،Play  يا Print را از دومين منوي بازش��وي  Parameters انتخاب 

كنيد.
8- اگ��ر از دومين منوي بازش��وي  Parameters گزين��ه Go To and Stop/Play يا Print را 
انتخاب كرديد، براي تعيين اين كه كدام بخش از س��ند بايد نمايش داده شود يا چاپ شود، 

از سومين منوي بازشوي Parameters استفاده كنيد.

 مثال 4: در صورتي كه س��ندي از قبل ايجاد كرديد مس��ير File→Open را اجرا 
کنيد تا س��ند موردنظر باز شود، سپس مس��ير View→Fit All را اجرا کنيد تا محتواي فايل 

موردنظر که به عنوان مثال در شكل 25-14چهار صفحه‌اي است، مشاهده شود.

  

شکل 25-14 فايل چهار صفحه‌اي      

1- در اي��ن مث��ال از صفحه اول در لايه Screen  طبق ش��کل 26-14 ش��ئ مورد نظر را 
برگزينيد. 
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شکل 26-14 انتخاب شئ لايه  Screenدر صفحه اول

2- پنل Navigation را از مسير Window→Navigation باز كنيد.
 Parameters و از اولين منوي بازشوي  Go To and Stop گزينه Action 3- از منوي بازشوي

صفحه دوم را انتخاب کنيد، در منوي بازشوي دوم Parameters ، لايه PDA ظاهر مي‌شود.
4- پيش‌فرض منوي بازشوي Event، رويداد Press است )شکل 14-27(. 

 Navigation ايجاد شده در پنل Actionشکل 27-14 نمايش

به اين ترتيب کي Action  ايجاد کرده‌ايد که در پنجره Flash Player  با کليک ماوس روي 
شئ Screen  در صفحه اول، صفحه دوم ظاهر مي‌شود )شکل 14-28(.

5- حال از منوي بازش��و Event گزينه Over  را برگزينيد )ش��کل 29-14(. به اين ترتيب 
کي Action  ايجاد کرد‌ه‌ايد که در پنجره Flash Player، با قراردادن اش��اره‌گر ماوس روي شئ 

Screen  در صفحه اول، صفحه دوم آشکار شود.

شکل Action 14-28 ايجاد شده از صفحه اول به صفحه دوم   
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Over شکل 29-14 انتخاب رويداد

 6- با ابزار Pointer در صفحه دوم، شئ لايه Screen  را انتخاب کنيد. از منوي Action گزينه
Go To and Stop را برگزينيد. به اين ترتيب علامت Action Proton در گوش��ه س��مت راست 

پايين شئ  Screen مشاهده مي‌شود.
7- در اولي��ن منوي بازش��و Page3 ،Parameters را انتخاب کنيد. خط آبي رنگ تا ش��ئ 

صفحه سوم ادامه ميي‌ابد )شکل 14-30(.

شکل Action 14-30 ايجاد شده از صفحه دوم به صفحه سوم

8- از منوي بازش��و Event، گزينه Over  را انتخاب کنيد. به اين ترتيب کي Action  ايجاد 
کرده‌ايد که در پنجره Flash Player با کليک ماوس روي شئ Screen  از صفحه دوم به صفحه 

سوم مي‌رويد.
 FreeHand امکان تست فيلم در داخل برنامه Window→Movie→Test 9- با اجراي مسير
فراهم مي‌آيد و فايل فيلم Flash با فرمت SWF در پنجره Flash Player مش��اهده مي‌شود که 

محتويات صفحه اول را نشان مي‌دهد )شکل 14-31(.
1- با قراردادن ماوس روي شئ صفحه اول، صفحه دوم نمايان مي‌شود )شکل 14-31(.

11- در صفحه دوم اگر براي اش��ياي آن Action تعريف شده باشد، شکل اشاره‌گر ماوس 
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به صورت دس��ت تبديل ‌شده و ش��ئ مربوطه تيره‌تر از ساير اشياء مي‌شود كه با کليک روي 
آن، صفحه سوم در پنجره Flash Player مشاهده مي‌شود )شکل 14-32(.

            

 Flash شکل 32-14 نمايش و تست فيلم                    Flash شکل 31-14 نمايش و تست فيلم                 

Movie Settings و Flash Movie 4-6-14 آشنايي با
در برنامه FreeHand مي‌توانيد Flash Movie 1را در داخل سند FreeHand وارد کرده و به 

صورت تعاملي در وب نمايش دهيد. 

 توجه: فايل Flash با فرمت SWF از طريق اجراي مس��ير File→Import در س��ند وارد 
مي‌شود.

بايد به اين نكته توجه داش��ته باش��يد كه فايل Flash با فرمت FLA فايل قابل ويرايش در 
 Flash Movie اس��ت و با اس��تفاده از آن مي‌توان کي Macromedia Flash MX محيط برنامه

)فيلم Flash( که فرمت آن SWF است، ايجاد كرد )شكل 14-33(.

FreeHand شده در سند Import شکل 33-14 نمايش فيلم
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 FreeHand با استفاده از سند Flash امکان ايجاد کي فيلم سفارشي FreeHand در برنامه
 Movie Settings کادر محاوره ،Flash وج��ود دارد. براي انجام تنظيم‌هاي مورد نظر در فيل��م

به‌کار مي‌رود.
Movie Settings روش اجراي

1- فيلم موردنظر )فيلم ايجاد شده در مثال 4( را در سند وارد کنيد.
2- مسير Window→Movie→Settings را اجرا کنيد.

در کادر محاوره Movie Settings مش��خص مي‌ش��ود که لايه‌هاي موجود در صفحه سند 
FreeHand چگونه به فريم‌هاي فيلم Flash تبديل مي‌شوند.

 توجه: در متحرك‌سازي، لايه‌هاي پنهان و لايه Guides ديده نمي‌شوند.

در اين كادر محاوره سه ناحيه مختلف وجود دارد )شكل 14-34(.
1- در ادامه اجراي مثال‌، گزينه Flatten را در بخش Layers  انتخاب كنيد تا همه لايه‌هاي 

موجود در صفحه‌هاي سند ادغام شده و در کي Frame قرار گيرند )شکل 14-34(.
2- در Page Range محدوده صفحه را 1 تا 3 قرار دهيد. در اين‌ صورت صفحه 4 در فيلم 
ايجاد ش��ده در نظر گرفته نمي‌ش��ود و حجم فايل Movie نسبت به حالت 4 صفحه‌اي کمتر 

مي‌شود.
3- دکمه OK  را کليک کنيد. 

شکل 34-14 کادر تنظيمات فيلم ايجاد شده در مثال 4 	
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FreeHand در داخل محيط Flash ويرايش فايل
اگر برنامه Macromedia Flash MX و  FreeHand MX هر دو در رايانه نصب ش��ده باش��ند؛ 

مي‌توانيد فايل Flash با فرمت FLA را در برنامه FreeHand ويرايش کنيد.
روش اجرا:

1- فيلم Flash موردنظر را که مي‌خواهيد ويرايش کنيد، در صفحه Import کنيد.
2- در پنل Object روي دکمه ويرايش Flash کليک كنيد، س��پس در کادر محاوره ظاهر 
شده، فايل فيلم Flash موردنظر را با فرمت FLA )فرمتي که سبب ايجاد فيلم Flash با فرمت 

SWF مي‌شود( انتخاب کرده و در صفحه ظاهر کنيد )شکل 14-35(.

3- ويرايش مورد نظر را انجام داده، س��پس روي Done کليک کنيد )شکل 35-14(. در 
اين صورت فايل Flash بسته مي‌شود و به سند FreeHand باز مي‌گرديد. 

 نكته: اگر كادر انتخاب Show Snapshot فعال باش��د، مي‌توانيد نمايشي از يكي ‌از 
فريم‌هاي فيلم را ببينيد.

FreeHand در داخل Flash شکل 35-14ويرايش فايل

تمرين 3: تنظيم ويژگي‌هاي کي فيلم Import ش��ده در س��ند FreeHand را با 
استفاده از پنل Object که در شکل 36-14 مشخص شده، بررسي کنيد.
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شکل 14-36

HTML با فرمت Web در FreeHand 7-14  انتشار سند
ويژگي‌هاي وب FreeHand براي طراحي يك وب س��ايت ب��هك‌ار نمي‌رود بلكه براي مواردي 
  Publish as HTMLنظير تبديل يك بروش��ور به مجموعه‌اي از صفحات وب مفيد است. با فرمان
س��ند FreeHand به س��ند HTML تبديل مي‌ش��ود و مي‌توانيد مانند صفحات وب آن را در 

مرورگر وب مشاهده کنيد.
 ب��ا اج��راي فرم��ان File→Publish as HTML كادر مح��اوره HTML Output مطاب��ق 
 ،HTML به فرمت FreeHand ش��كل  37-14 نشان داده مي‌ش��ود. مي‌توانيد براي تبديل سند
تنظيم��ي را از من��وي HTML Setting انتخاب كرده يا تنظيم جديدي )با اس��تفاده از دكمه 
Setup( را ايج��اد كنيد. امکان ويرايش تنظيم پيش‌فرض و تنظيم‌هاي ايجاد ش��ده نيز وجود 

دارد.
	

شکل 14-37
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 HTML كليك كنيد كادر محاوره Setup روي دكمه HTML Output  اگ��ر در كادر محاوره
Setup باز مي‌شود )شكل 14-38(.

HTML به فايل FreeHandشکل 38-14 کادر ايجاد و ويرايش تنظيم تبديل سند

در اين كادر تنظيماتي مانند محل ذخيره‌س��ازي سند HTML، قالب‌بندي و صفحه‌آرايي 
آن، رمزگ��ذاري قلمي که در صفحه به‌کار مي‌رود، تعيي��ن فرمت و نوع فايل براي اثر هنري 
 FreeHand در پوش��ه‌اي به نام HTML وجود دارد. محل ذخيره س��ند )Vector ي��ا Bitmap(

HTML Output در روي صفحه Desktop است. 

1-7-14 ايجاد سند

1- سند FreeHand مورد نظر را باز و مسير File→Publish as HTML را اجرا کنيد.
 ،HTML کيي از موارد زير را براي انتخاب تنظيمات HTML Output 2- در کادرمح��اوره‌

در بخش HTML Setting انجام دهيد:
تنظيم پيش‌فرض يا تنظيمي را که ايجاد کرده‌ايد، انتخاب کنيد. اگر تنظيمي ايجاد  	

نکرده‌ايد فقط تنظيم پيش‌فرض ديده مي‌شود.
روي دکمه Setup کليک کنيد تا کادر محاوره HTML Setup ظاهر شود.	

روي دکمه Wizard کليک کرده، دستوراتي که براي انتخاب تنظيمات HTML	 ارائه 
مي‌شود دنبال كنيد و با کليک روي دکمه Finish به کار پايان دهيد. 

3- پس از انجام تنظيمات مورد نظر روي دکمه Save as HTML کليک کنيد.
HTML Output 2-7-14 ايجاد و ويرايش تنظيم‌هاي

1- روي گزين��ه File→Publish as HTML كليك کنيد تا کادرمحاوره HTML Output در 
صفحه ظاهر شود.
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2- روي دکمه Setup  کليک کنيد تا کادر HTML Setup ظاهر شود.

Name for new HTML Setting شکل 39-14 درج نام تنظيم جديد در کادر متني

3- کيي از مواردي را كه در ادامه گفته شده با توجه به نيازتان اجرا کنيد.
براي ايجاد تنظيم جديد، روي علامت + کليک کنيد تا کادر ش��كل 39-14	 آش��کار 
ش��ود. س��پس نام تنظيم جديد را در کادر متني مربوط به آن وارد و دکمه OK را 

کليک کنيد.
 	HTML Setting که قبلًا ايجاد ش��ده، از منوي بازش��و HTML براي ويرايش تنظيم

تنظيم مورد نظر را انتخاب کنيد )شکل 14-40(.

شکل 40-14 انتخاب تنظيم موردنظر براي ويرايش

4- محل ذخيره ‌س��ند HTML را با کليک روي دکمه Browse و تعيين پوش��ه نگهداري 
فايل HTML مشخص کرده و روي دکمه Select کليک کنيد.

مثال 5: صفحه FreeHand نش��ان داده شده در شکل 41-14 را براساس تنظيم 
پيش‌فرض به صورت HTML تبديل کنيد. 

 File→Publish as HTML شكل 41-14 را ايجاد كنيد، سپس مسير FreeHand 1- سند
را اجرا کنيد.

2- در کادر محاوره    HTML      Output، تنظيم پيش‌فرض را انتخاب کنيد )شکل 14-42(.
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شکل 41-14                                            شکل 14-42

3- از قس��مت Pages گزين��ه All را انتخاب كنيد تا تنظيم��ات روي تمام صفحات اعمال 
شود )شكل 14-42(.

4- با کليك روي دکمه Browse برنامه مرورگر يا ويرايشگر موردنظر را انتخاب نماييد.
5- روي دکمه Save as HTML کليک کنيد )شکل 14-42(. 

تمري�ن 4: کي فايل FreeHand با ن��ام T14 -3  ايجاد كنيد كه داراي دو صفحه 
باشد. در صفحه اول آن کي تصوير Import ،Bitmap شده و در صفحه دوم آن شکل 14-43 

قرار داده شود، با توجه به موارد خواسته شده آن را به فرمت HTML تبديل کنيد.
1- خروجي در مرورگر وب دلخواه مشاهده شود.
2- کادر هشدار در جريان تبديل مشاهده شود.

شکل 14-43
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1 URL 8-14 انتساب يک
يك��ي از مهم‌ترين ويژگي‌هاي صفحه وب كه در HTML وج��ود دارد، قابليت لينك‌هاي 
URL است. اين لينك‌ها يا پيوندها به شما امكان مي‌دهد تا روي يك كلمه، عبارت يا تصوير 

كليك كنيد و به مكان ديگري در وب س��ايت جاري يا سايت ديگر منتقل شويد. براي ايجاد 
 Navigation که در پنل Link مي‌توانيد از کادر متني URL بين ش��ئ يا متن و )Link( پيوند

است، استفاده کنيد.
 HTML يا PDF ،SWF است در فايلي با فرمت URL که حاوي FreeHand وقتي کي سند
صادر شود در اين صورت کليک روي شئ متصل شده به آدرس URL، سبب پرش به صفحه 

وب مورد نظر مي‌شود.
1-8-14 انتساب URL به شئ

1- شيئي را انتخاب كنيد كه مي‌خواهيد پيوند )لينك( به آن اعمال شود.
2- در پنل Navigation آدرس URL را در كادر Link تايپ كنيد )شكل 14-44(.

ي��ا اگ��ر قبلًا لينكي را به س��ند اضافه كرده‌ايد، از منوي بازش��و Link براي انتخاب پيوند 
موردنظر استفاده نماييد.

شکل 14-44

 نكت�ه: اگر با چندين صفحه در س��ند كار ميك‌نيد، از منوي Link براي انتخاب 
يك پيوند به صفحه ديگر استفاده كنيد.

پنل Navigation اين امکان را مي‌دهد که کي URL	 را به اش��ياء نسبت دهيد، اشياء 

را بررسي کنيد و مشخص کنيد که چه URLهايي به آن‌ها متصل است،URL  همه 
اشياء را به‌روز کنيد و شئ‌هايي را که به کي URL خاص متصل هستند، بيابيد.

Uniform Resource Locator  -1: مشخص کننده منحصر به فرد منبع، آدرس منحصر به فرد صفحات وب



Free Hand پیمانه مهارتی : کاربر
واحد کار چهاردهم: توانایی متحرک سازی و استفاده از سند FreeHand در صفحات وب 

423

منوي Substring	 کلمه يا عبارت‌هايي را نش��ان مي‌دهد که داخل بلوک متني فعال 
است و به يك URL در کادرLink  متصل است.

2-8-14 انتساب URL به متن	

1- در فايل FreeHand، متن يا بلوک متني که مي‌خواهيد URL را به آن نسبت دهيد با 
ابزار Text انتخاب کنيد. 

2- مسير Window→Navigation را براي فعال کردن پنل Navigation اجرا کنيد.
3- در منوي Link، آدرس URL موردنظر را درج يا از منوي بازش��و Link، آن را انتخاب 

کنيد. در اين صورت متن انتخابي در کادر Substring آشکار مي‌شود. 
URL 3-8-14 به روز کردن

1- در سند جاري همه اشياء را از حالت انتخاب خارج کنيد.
2- در پن��ل Navigation ي��ک URL را از منوي بازش��و Link، انتخاب يا يك URL را وارد 

كنيد.
3- روي دکمه جس��تجو  که در س��مت راست منوي بازش��و Link قرار دارد، کليک 

کنيد.
4- تمام اشياي موجود در سند جاري كه به URL لينك شده‌اند، انتخاب مي‌شوند.

در اي��ن ص��ورت URL براي همه اش��ياي متصل )Link( به آن در س��ند ج��اري به روز 
مي‌شوند.

URL 4-8-14 جستجوي اشياي متصل شده به
 URL يك Link آدرس را درج کرده يا از منوي بازش��و Link در كادر ،Navigation 1- در پنل

انتخاب کنيد.
کني��د  کلي��ک   ، Link من��وي  راس��ت  س��مت  در    Find Button دکم��ه  روي   -2 

3- تمام اشياي موجود در سند جاري كه به URL  متصل شده‌اند، در سند انتخاب مي‌شوند.
هنگامي که URL را به شئ سند FreeHand که داراي خط دور )Stroke( است، نسبت مي‌دهيد؛ 
وقتي کاربر ‌اشاره‌گر ماوس را روي خط حرکت دهد پيوند ايجاد شده در سند HTML فعال خواهد 

شد.
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Navigation شکل 45-14نمايش دكمه جستجو در پنل

 مثال 6: درفايل FreeHand نشان‌داده‌ش��ده در ش��کل 46-14 کي Link از شئ 
 C:\Documents and Settings\ma\FreeHand متني ب��ه صفحه وب‌ ذخيره ش��ده ‌در مس��ير

html.Output\Untitled001 ايجاد کنيد.

1- پس از ايجاد شکل 46-14در سند FreeHand، متن درج شده را انتخاب کنيد.
2- پنل Navigation را فعال کنيد.

3- در کادر Link، آدرس صفحه HTML موردنظر را درج کنيد.
4- در کادر Substring عبارت انتخاب شده مشاهده مي‌شود )شکل 14-46(. 

        

شکل 14-46

5- فايل FreeHand را به HTML تبديل کنيد )شکل 14-47(.
6- با کليک روي عبارت show button صفحه Link شده به‌آن قابل ‌مشاهده‌ است )شکل 

سمت چپ 14-47(.	
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شکل 14-47

5-8-14 فشرده‌سازي اثر هنري )Artwork( براي نمايش در وب

وقت��ي تصويرها را براي نمايش در وب آماده مي‌کنيد، حجم تصويرهاي فش��رده ش��ده، 
کاه��ش يافته و روي رن��گ تصويرهاي به نمايش درآمده در وب و س��اير ويژگي‌هاي تصوير 

کنترل‌هاي لازم انجام مي‌شود.
اثر هنري Bitmap در FreeHand به صورت JPEG ،GIF يا فرمت PNG فش��رده مي‌ش��ود. 
اث��ر هنري برداري ب��ا فرمت SWF، صادر مي‌ش��ود )Export( و به اين ترتيب فايل ايس��تاي 

FreeHand به کي سند پويانمايي با Action هاي Flash تبديل مي‌شود.

در فشرده‌س��ازي کاره��اي از ن��وع Bitmap بايد قالبي انتخاب ش��ود که اس��اس رنگ و 
مشخصه‌هاي تن‌هاي رنگي اثر هنري اصلي را حفظ کند و نوع مرورگر براي مشاهده صفحه 

نيز در اين مورد مؤثر است.
به‌طورکلي فرمت GIF بهترين حالت براي تصويرس��ازي و طراحي با رنگ‌هاي Flat	 و 

يكنواخت است، مثل رنگي که در متن به‌کار مي‌رود.
قالب JPEG	 بهترين حالت براي اثر هنري با محدوده گسترده و دامنه‌اي از تناليته‌هاي 
پيوسته رنگ است، مثل اثر هنري که در آن رنگ گراديان به کار رفته يا عکس‌هايي 

که اسکن شده‌اند.
فرم��ت PNG مانند JPEG	 محدوده وس��يعي از رنگ را دربرمي‌گي��رد اما غالباً بهك‌ار 

نمي‌رود زيرا فقط امكان نمايش در برخي از مرورگرها را دارد.



وزارت فرهنگ و ارشاد اسلامی
Free Hand نام استاندارد : کاربر

شماره : 15/7- ف - هـ
426

واژه‌نامه 
Actionحرکت، عمل

Flash Playerنمايشگر برنامه

Interactiveتعاملي

Target Pageصفحه مقصد

Navigationجهتي‌ابي

Parametersپارامترها

Unloadعدم بازيابي

Sequenceترتيب، توالي

Trailکشيدن، کشيده شدن

خلاصه مطالب
در اين واحدکار مواردي که سبب نمايش سند FreeHand در وب و ايجاد اثر گرافيکي و 

پويانمايي تحت وب مي‌شود، به شرح زير بررسي شد:
انتساب کي Flash Action به شئ سند FreeHand	 و ايجاد فيلم تعاملي در وب

( براي اس��تفاده در اثر  	SWF( Flash در قالب فاي��ل FreeHand اث��ر هن��ري Export

برداري پويا و نمايش آن در وب.
 	Flash با استفاده از پنجره FreeHand در داخل Flash پيش‌نمايش و تست فيلم‌هاي

.Player

 	FreeHand براي تبديل سندXtras→Animate→Release to Layers  استفاده از فرمان
به صورت کي انيميشن.

. 	Publish as HTML با استفاده از فرمان HTML به FreeHand تبديل سند
انتس��اب لين‌کهاي URL به اش��ياء يا متن در س��ند FreeHand	 با اس��تفاده از پنل 

.Navigation

فشرده‌س��ازي آث��ار FreeHand در قالب JPEG ،GIF يا PNG	 براي نمايش س��ند به 
.HTML صورت
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آزمون نظري
درستي يا نادرستي گزينه هاي زير را تعيين کنيد.

Over -1، رويداد حرکت ماوس روي شئ است.

2- زماني که براي کي ش��ئ، Action تعريف مي‌کنيد در گوش��ه بالا س��مت راست آن، 
علامتي به نام Action Proton ظاهر مي‌شود.

 Play( پرش به کي فريم و توقف تکرار صحنه  Go To and Stop،Action 3- با استفاده از
Back( انجام مي‌شود.

Action -4ه��اي Load/Unload Movie وTell Target  در صورتي فعال هس��تند که س��ند 

حداقل سه صفحه داشته باشد.
 Macromedia Flash MX فايل قابل ويرايش در محيط برنامه FLA با فرمت Flash 5- فايل

است.
معادل گزينه هاي سمت‌راست را از ستون سمت‌چپ انتخاب کرده و مقابل هر عبارت بنويسيد.

Link to Target Page              .6- جلوه حرکتي است که به کي موضوع داده مي‌شود
7- صفحه‌اي که محل پايان يافتن Action  را مش��خص مي‌کند و عمل رها کردن ماوس 
Action                                                                                    .در آن انجام مي‌شود )Drop(

                   Release to Layers                  .8- کي اتصال و پيوند به صفحه مقصد ايجاد مي‌کند
Blend  -9، بلو‌کهاي متن، اشياء گروه‌بندي شده و متن متصل به کي مسير با اين فرمان 

Target Page                                                                         .متحرک مي‌شوند
گزينه صحيح را انتخاب کنيد.

10-کدامي‌��ک از Actionها، براي نمايش فيل��م در حالت تمام صفحه و بزرگ‌تر از حالت 
معمولي انجام مي‌شود؟

The Print action -ب 	The Tell Target action -الف
  The Full Screen action-د 	The Play and Stop actions -ج

11- كدامي‌ك از گزينه‌هاي انيميش��ن، اش��ياء را به تعداد لايه‌هايي که مشخص مي‌کنيد 
کپي و پخش مي‌کند؟

Build  -د             Drop  -ج           Sequence  -ب       Trail  -الف 
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12- كدام فرمت بهترين حالت براي تصويرسازي و طراحي با رنگ‌هاي Flat است؟
SWF -د         	JPG -ج 	 GIF -ب       PNG -الف

13- كليد تركيبي Ctrl+Enter چه عملي انجام مي‌دهد؟
الف- صدور فايل حركتي به وب        ب- قرار دادن اشياء در فريم

		       د- اعمال جلوه حركتي به شكل ج- تست و اجراي فيلم
در جاي خالي عبارت مناسب را بنويسيد.

14- با فرمان .................. س��ند FreeHand به س��ند HTML تبديل مي‌ش��ود و مي‌توانيد 
مانند صفحات وب آن را در مرورگر وب مشاهده کنيد.

 Flash براي ........... و ........... کي فيلم ،The Load Movie and Unload Movie actions  -15

در داخل فيلم Flash جاري )فيلم در حال نمايش( است.
به سؤالات زير پاسخ تشريحی دهيد.

16- اعمال )Go To and Play )Action با Play چه تفاوتي دارد؟
17- ابزار Action Tool چه كاري انجام مي‌دهد؟ نام ببريد.
18- در شکل زير نام دکمه‌هاي مشخص شده را بنويسيد.
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آزمون عملي
1- متن اين ش��کل را رس��م ک��رده ب��ا اس��تفاده از فرم��ان Release to Layers روي آن 

متحر‌کسازي با جلوه Trail ايجاد کنيد.

2- موارد خواسته شده را اجرا کنيد:
کي س��ند FreeHand	 که دوصفحه‌اي اس��ت ايجاد کرده و شکل‌هاي الف و ب را در 

صفحه اول و دوم آن قرار دهيد.                                                    
ترتيبي دهيد که با اس��تفاده از فايل FreeHand، کي Flash Movie	 ايجاد شود که با 
حرکت ماوس روي شئ اول، شئ دوم ظاهر شود.                                            

3- کي س��ند FreeHand سه صفحه‌اي شامل تصوير Bitmap و ترسيم برداري ايجاد و آن 

را به کي فايل HTML تبديل کنيد. ترتيبي دهيد که دو صفحه از سه صفحه فايل به فرمت 
HTML تبديل شوند.

4- با استفاده از پنل Navigation بين شکل زير و کي سند HTML دلخواه، ارتباط برقرار 
کنيد.
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کليات 
تاکنون با امکانات و توانايي‌هاي متعدد برنامه گرافيکي FreeHand آش��نا ش��ده‌ايد. گاهي 
اوقات هنگام طراحي لازم مي‌ش��ود براي تکميل طرح، فايل ترسيمي را به کي نرم‌افزار ديگر 
ب��رده و روي آن تغييرات لازم را انجام دهيد همچنين ب��راي خروجي گرفتن از کار طراحي 
نهايي بايد بتوانيد با فرمان Print ترس��يمات را چاپ کنيد. بدين منظور در اين واحد کار به 
بررس��ي نحوه صدور فايل و فرمت‌هاي پشتيباني شده براي صدور فايل همچنين نحوه چاپ 

فايل و تصاوير ايجاد شده در FreeHand خواهيم پرداخت.
Export 1-15 فرمان

چنانچه بخواهيد از فايل ترسيمي در کي برنامه گرافيکي ديگر غير از FreeHand استفاده 
کنيد، لازم است فايل را با فرمتي ذخيره کنيد که با برنامه مقصد سازگاري داشته باشد، در 
اين صورت از فرمان Export استفاده کنيد. همچنين با استفاده از اين فرمان مي‌توان فايل‌ها 

را به فرمت‌هاي گوناگون تبديل و ذخيره کرد.
FreeHand انواع فرمت‌هاي گرافيکي برداري و پيکس��لي را پش��تيباني مي‌کند. مي‌توانيد 

فايل‌هاي گرافيکي يا متني را به فرمت‌هاي زير Export نماييد:
	 BMPو GIF ،JPEG ،TIFF ،PNG ،PSD با فرمت‌هاي Bitmap تصاوير

 	Flash به منظ��ور نمايش در مرورگر وب ي��ا برنامه SWF ب��ا فرمت Flash فيلم‌ه��اي
Player

و  	Enhanced Metafile (EMF( فرمت‌ه��اي  ب��ا   )Vector( ب��رداري   گرافي‌که��اي 
 Windows Metafile (WMF(

	FreeHand 8, 9, 10 فايل‌هاي
	  Illustrator فايل‌هاي

اس��ناد ايجاد ش��ده با فرمتPDF  که توس��ط برنام��هAdobe Acrobat 	 نمايش داده 
مي‌شوند.

	RTF و ASCII   مثل )Text( فرمت‌هاي متني
در مورد انواع فرمت‌ها قبلًا در واحد کار 3 توضيح داده شده است.

به‌منظور صادر کردن فايل طراحي ش��ده به نرم‌افزارهاي ديگر از فرمان File→Export يا 
کليد تركيبي Ctrl+Shift+R استفاده کنيد تا کادرمحاوره Export Document در صفحه ظاهر 
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شود )شکل 15-1(.

Export Document شکل 1-15 کادر محاوره

 مثال 1: آرم نشان داده شده در شکل 2-15 را طراحي کنيد؛ سپس آن را با نام 
Arm1 و پس��وند JPG به برنامه Paint ويندوز ص��ادر کرده و از طريق آن برنامه، کلمه ITP را 

جدا کرده و به زير شکل منتقل کنيد.

شکل 15-2

1- ابتدا طراحي آرم را با ابزارهاي مناسب انجام دهيد.
2- از منوي File گزينه Export را برگزينيد.

3- در کادر محاوره ظاهر شده در کادر متني File name نام Arm1  را وارد کنيد.
4- در منوي بازشوي Save as type پسوند JPG را انتخاب کنيد.

5- گزينه Open in external application را فعال کنيد و در کادر محاوره باز ش��ده، فايل 
mspaint.exe را از پوشه ويندوز انتخاب کنيد.
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6- روي دکمه Save کليک کنيد تا وارد برنامه Paint شويد.
7- در اين برنامه با ابزار Select متنITP  را انتخاب کرده و به زير شکل منتقل کنيد.

تمرين 1: براي کي ش��رکت کامپيوتري، کارت ويزيتي مطابق ش��کل 3-15 به 
 Photoshop ابعاد 5×9 س��انتي‌متر و به صورت افقي، طراحي کنيد؛ س��پس آن را به نرم‌افزار

ارسال کرده و براي زيبايي کار روي آن چند فيلتر مناسب اعمال کنيد.

شکل 15-3

 توج�ه: دکم��ه Setup ب��راي اعمال کنترل بر فايل ارس��الي به‌کار م��ي‌رود که در 

فرمت‌هاي مختلف تنظيمات گوناگوني دارد.

1-1-15 نحوه صدور برخي فايل‌ها 

براي‌تنظي��م صدور هر فرمت نظير JPG ،GIF ،TIFF ،BMP و PNG  روي دكمه Setup در 
كادرمحاوره‌ Export Document كليك كنيد. در اين صورت كادري مطابق ش��كل 4-15 باز 

مي‌شود.

شکل 15-4

در منوي بازشو Resolution مقدار وضوح را براي اكثر كارهاي چاپي dpi 300	 و براي 
وب مقدار dpi 72 در نظر بگيريد.

براي هموار كردن لبه‌هاي تصوير، مقدار Anti-aliasing را انتخاب كنيد.	
 	Include alpha براي صادر كردن كانال آلفا كه به عنوان ماس��ك بهك‌ار مي‌رود گزينه
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channel را كليك نماييد. اگر براي تصوير يك كانال آلفا ايجاد كرده باشيد، مي‌توانيد 

از FreeHand براي نش��ان دادن يا مخفي كردن اين كانال اس��تفاده كنيد. اگر كانال 
آلفا قابل رؤيت نباشد تصوير كامل را مي‌بينيد.

كارگي��ري لايه پس‌زمينه به  انتخ��اب گزينه Alpha includes background س��بب به‌	
عنوان كانال آلفا1 مي‌شود )شكل 15-5(.

شکل 15-5

 نكت�ه: FreeHand به ش��ما امكان مي‌دهد كه كانال‌هاي آلف��اي تصاوير با فرمت 
PNG ،TIFF و GIF را نمايش دهيد.

 Export Again 2-15 فرمان
پس از صدور کي فايل، ممکن اس��ت بخواهيد تغييراتي را در س��ند اصلي ايجاد کنيد و 

سپس بدون تنظيم کادر محاوره Export مجدداً فايل مزبور را صادر کنيد.
 FreeHand را اجرا کني��د. در اين صورت File→Export Again ب��راي اين منظور فرم��ان
بدون استفاده از تنظيم كادرمحاوره Export فايل را با همان نام و پسوند در مسيري که قبلًا 

Export شده بود، ذخيره و صادر مي‌کند.

Email  3-15 ارسال يک سند به‌صورت
در صورتي که ويندوز شما داراي سيس��تم نامه الکترونيکي MAPI32-Compliant باشد، 
 Mail يا تمام س��ندهاي باز شده متصل به آن را ارسال يا FreeHand مي‌توانيد س��ند فعال در

نماييد. مراحل کار به صورت زير است:
1- گزينه File→Send را انتخاب کنيد.

2- با توجه به عملي که مي‌خواهيد انجام دهيد کيي از روش‌هاي زير را اجرا کنيد:
1- كانال آلفا انتخابي است كه به عنوان ماسك و به شكل تصاوير خاكستري ذخيره مي‌شود.
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براي اتصال )Attach( سند فعال به پيام E-mail، نام فايل را انتخاب کنيد.	
، گزينه 	E-mail تمام اس��نادي که به تازگي باز شده‌اند، به پيام )Attach( براي اتصال 

All Open Documents را انتخاب کنيد.

اگر براي اولين بار کي سند را به صورت نامه الكترونيكي Mail يا ارسال کنيد کي پنجره 
ظاهر مي‌شود و از شما مي‌خواهد که کي پروفايل را تنظيم کنيد. براي کسب اطلاعات بيشتر 

به مستندات برنامه کاربردي E-mail  خود مراجعه نماييد.
3- در صورت نياز، پيام‌هاي مورد نظر را به متن نامه خود اضافه نماييد.

4- پس از درج آدرسE-mail  ش��خصي که مي‌خواهيد نامه را به او ارس��ال کنيد، روي 
دکمه Send  کليک کنيد.

اسناد به نامه متصل1 مي‌شوند. در صورتي که براي سند جاري که آن را ارسال نموده‌ايد 
نامي تعيين نکرده باشيد، با همان نام پيش‌فرض خود در FreeHand ارسال مي‌شوند. 

Print 4-15 فرمان
پس از تکميل کار طراحي معمولاً لازم اس��ت که نمونه‌اي از آن را روي کاغذ مش��اهده 

کنيد و به اصلاح اشکالات احتمالي آن بپردازيد.
عمل چاپ را مي‌توان به دو روش انجام داد که عبارتند از چاپ خانگي و چاپ تجاري يا 

صنعتي. در اين بخش، کار با ابزارهاي چاپ خانگي مورد بحث و بررسي قرار گرفته است.
 Print نصب شده باشد، مي‌توان از روش‌هاي زير کادر محاوره )Printer( در صورتي که چاپگر 

)شکل 6-15( را باز کرد:
 Print گزينه File روش 1: منوي

Main روش 2: کليک روي آکين  در نوار ابزار
 Ctrl+P روش 3:  به‌کار بردن کليد ترکيبي

پس از باز شدن کادر محاوره Print و قبل از تأييد اين کادر و شروع عمل چاپ، ابتدا بايد 
گزينه‌هاي آن را تنظيم و کنترل کنيد.

 1- Attach        
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Print شکل 6-15 کادر محاوره

 Print 1-4-15 گزينه‌هاي کنترلي کادر محاوره

Printer -1: در منوي بازشوي اين قسمت مي‌توان نوع چاپگري را که به کامپيوتر متصل 

است، انتخاب کرد. 
Properties -2: با کليک روي اين دکمه، کادرمحاوره تنظيمات چاپگر فعال ظاهر مي‌شود 

که از اين طريق مي‌توان اندازه کاغذ، نوع کاغذ، Resolution چاپگر و غيره را تعيين کرد.
Print Range  -3 : در اين قس��مت محدوده چاپ تعيين مي‌ش��ود که شرح آن به صورت 

زير است:
All: انتخاب اين گزينه سبب چاپ تمام صفحات سند جاري مي‌شود.	

Current page: اين گزينه فقط صفحه جاري را چاپ مي‌کند.	

Area: براي چاپ ناحيه تعريف شده توسط ابزار Output Area 	 واقع در جعبه 

ابزار Tools، از اين گزينه اس��تفاده مي‌شود )اصول کار با ابزار Output Area در ادامه 
همين فصل آورده شده است(.

Pages:	 با وارد کردن ش��ماره صفحات خاص در اين قسمت، تنها صفحات مورد نظر 

چاپ مي‌شوند.
Page boundary:	 اگر‌مي‌خواهي��د صفحات‌متع��ددي را در‌کيصفح��ه چاپ‌کني��د، 

مي‌توانيد اين گزينه را انتخاب کنيد تا لبه‌هاي صفحه در خروجي چاپ نهايي نشان 
داده شوند.

انتخاب ‌اين‌گزينه س��بب مي‌ش��ود که فقط موضوع انتخابي چاپ  	 :Selected objects



Free Hand پیمانه مهارتی : کاربر
 FreeHandMX واحد کار پانزدهم: توانایی ارسال و چاپ گرافکی در نرم افزار

437

شود.
Output -4: در اين قسمت گزينه‌هاي زير به‌کار مي‌رود:

Copies:	 در اين کادر متني مي‌توان تعداد کپي‌ها از صفحات مش��خص ش��ده را وارد 

کرد.
Composite:	 انتخاب اين گزينه سبب مي‌شود که همه رنگ‌ها به صورت ترکيب شده 

در کي صفحه چاپ شوند يعني ترکيب تمام رنگ‌ها در چاپ نشان داده مي‌شوند.
Separations: اي��ن گزين��ه براي چاپگرهاي Postscript	 فعال مي‌ش��ود و چاپگرهاي 

معمولي قادر به چاپ رنگ‌هاي تفکيکي نيس��تند، با استفاده از اين گزينه رنگ‌ها به 
طور مجزا چاپ مي‌شوند. به عبارت ديگر براي هر کي از رنگ‌هاي جوهر که در ايجاد 

فايل مورد استفاده قرار مي‌گيرند چاپ جداگانه‌اي انجام مي‌گيرد.
Print to file:	 اطلاعات چاپ، به جاي اينکه به چاپگر ارس��ال ش��ود، درون کي فايل 

ذخيره مي‌شود تا بعداً از آن استفاده شود.
Convert Text: همه عبارات متني را به مسير تبديل مي‌کند.	

Preview -5: براي مشاهده پيش‌نمايش چاپ به كار مي‌رود )شکل 15-7(.

	 ب��راي کنت��رل صفح��ات در پيش‌نماي��ش چاپ، از منوي بازش��وي ش��ماره صفحه 
)شکل 7-15( استفاده کنيد.

منوي بازشوي انواع پيش‌نمايش به صورت زير است:	
Preview: پيش‌نمايش کار طراحي را با تمام زمينه‌ها و رنگ‌ها نشان مي‌دهد.

Keyline: اين نوع پيش‌نمايش، بدون نمايش رنگ‌ها و زمينه‌ها فقط مس��يرهاي طراحي 

را نشان مي‌دهد.
X-Box: در اين پيش‌نمايش، طراحي به صورت علامت × نشان داده مي‌شود.

تمرين 2: انواع حالت های Print Preview را مشاهده كرده و به تفاوت بين آن‌ها 
دقت كنيد.
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شکل 15-7

 توجه: با استفاده از درگ ماوس مي‌توانيد طراحي خود را به موقعيت‌هاي مختلف 

در ناحي��ه Print Preview منتقل کني��د. اگر بخواهيد طراحي به موقعيت اوليه بازگردد، روي 
ناحيه‌هاي خارج از پيش‌نمايش چاپ کليک کنيد.

Color Management -6: اين گزينه مربوط به مديريت و تفکيک رنگ‌هاست.
7- بخش %Scale: در منوي بازش��وي شکل 8-15 گزينه‌هايي وجود دارد که مي‌توان به 
وس��يله آن‌ها اندازه فايل چاپ شده را تغيير داد، بدون اين‌که روي فايل اصلي تأثيري داشته 

باشد.

Scale % شکل 8-15 بخش

Uniform:	 اين گزينه س��بب مي‌شود که با وارد کردن اعداد بزرگ‌تر يا کوچ‌کتر از 

100%، ابعاد فايل چاپ شده نسبت به تصوير اصلي بزرگ‌تر يا کوچ‌کتر شود بدون 
آن‌که تناسب تصوير تغيير کند.

Variable: مقي��اس تصوير را طبق مقادير مختلف ابعاد x و y	 تغيير مي‌دهد؛ زيرا در 

اي��ن حالت مي‌توان طول و عرض تصوير را مس��تقل از کيديگر تغيير داد، تصوير در 
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خروجي تغيير شکل مي‌دهد.
Fit on paper:	 ان��دازه تصوير را طوري تغيير مي‌دهد که با کاغذ موردنظر متناس��ب 

باش��د. به عبارت ديگر بدون توجه به ابعاد واقعي تصوير، تصوير چاپ ش��ده به اندازه 
حداکثر فضاي قابل چاپ صفحه کاغذ، تغيير خواهد کرد.

Tile -8 : اگ��ر کار طراح��ي موردنظر، بزرگ‌تر از کاغذ چاپگر اس��ت و نمي‌خواهيد اندازه 

آن را کاه��ش دهيد، مي‌توانيد گزينه کاش��ي‌کاري )Tile( را انتخاب کنيد که در اين صورت 
طراحي ش��ما به تعداد قطعات کاغذ تقسيم مي‌شود و هر قسمت در کي صفحه چاپ خواهد 

شد )شکل 15-9(.                                                            

شکل 15-9

منوي بازشوي Tile داراي گزينه‌هايي به اين شرح است:
با اس��تفاده از اين گزينه مي‌توانيد مکان ظاهر ش��دن قطعات کاغذ تقسيم  	 :Manual

شده را به‌طور دستي انتخاب کنيد.
مح��ل قرار گرفتن ه��ر کي از قطعات کاغذ را به‌ط��ور خودکار تنظيم  	 :Automatic

مي‌کند.
از قسمت Tile	 مي‌توان براي چاپ تصوير در چند قطعه روي کي کاغذ استفاده کرد 

که در اين صورت گزينه Overlap فاصله ميان قطعات را تعيين مي‌کند. 
 Printer Setup 15-4-2

اي��ن گزين��ه وظيفه تنظي��م ويژگي‌هاي چ��اپ پيش��رفته را برعهده دارد که از مس��ير 
File→Printer Setup، قابل دسترسي است.

 مثال 2: تنظيمات زير را براي چاپ انجام دهيد:
الف- تنها صفحه جاري که شکل 3-15 )تمرين 1( در آن قرار دارد دو بار چاپ شود.
ب- در محيط Print Preview شکل را در وسط صفحه قرار داده و سپس چاپ کنيد.

حل:
1- قب��ل از انج��ام اين تنظيمات، از نصب و وصل بودن چاپگر به سيس��تم خود مطمئن 

شويد.
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2- براي تنظيم قسمت الف، از منوي File گزينه Print را انتخاب کرده و در کادر محاوره 
باز شده موارد زير را انتخاب کنيد:

در قسمت Print Range گزينه Current page را انتخاب کنيد.	
در بخش Output در کادر Copies عدد 2 را وارد کنيد.  	   

3- براي انجام قس��مت ب، در کادر محاوره Print دکمه Preview را کليک کرده و ش��کل 
را به وسط صفحه درگ کنيد.  

4- دکمه OK را کليک کنيد تا عمل چاپ انجام گيرد.
تمرين 3: شكل 10-15 را ترسيم کنيد، سپس آن را انتخاب کرده و فقط ناحيه 
انتخاب ش��ده را به‌نحوي چاپ کنيد که تصوير چاپ شده به اندازه حداکثر فضاي قابل چاپ 

صفحه کاغذ باشد.

شکل 15-10

 )Color Management( 5-15 آشنايي با مديريت رنگ
گاهي اوقات بين تصاويري که در صفحه نمايش ديده مي‌ش��وند با نمونه چاپ شده آن‌ها 
تفاوت رنگ مشاهده مي‌شود. براي رفع اين مشکل و به‌منظور تنظيم ظاهر تصاوير در صفحه 
نمايش و پس از چاپ در FreeHand مي‌توان از Color Management يا مديريت رنگ استفاده 

نمود. 
صفحه نمايش، رنگ‌ها را با مد رنگ RGB نمايش مي‌دهد در صورتي که در هنگام چاپ، 
رنگ‌ها با اس��تفاده از مد رنگ CMYK چاپ مي‌شوند بنابراين بين رنگ‌هاي صفحه نمايش و 

رنگ‌هاي خروجي نهايي تفاوت وجود دارد.
کي سيستم مديريت رنگ )CMS(1، در صورت لزوم، رنگ را به نحوي تنظيم مي‌کند تا 
رنگ دس��تگاه‌هاي پيش‌نمايش )مانند صفحه نمايش( تا حد ممکن با رنگي که در خروجي 

 Color  Management System -1
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نهايي )چاپ( ايجاد خواهد شد هماهنگي داشته باشد. 
 Output Area 6-15 ابزار

توسط اين ابزار )شكل 17-15( مي‌توانيد کي ناحيه واحد Export را درون محيـط کاري 
براي سند تعريف كنيد. ناحيه Export مي‌تواند شامل نواحي انتخابي صفحه جاري و نواحي 
انتخابي Pasteboard )محيطي که شامل صفحات فايل است( باشد. همچنين مي‌تـوان براي 

تعريف ناحيه چاپ از اين ابزار استفاده كرد.

 نكته: درصورتي که بخواهيد شکل‌هاي رسم شده را چاپ کنيد و آن شکل‌ها در 
Pasteboard و خارج از محدوده صفحه باش��ند تنها با اس��تفاده از ابزار Output Area مي‌توان 

اشکال مورد نظر را چاپ كرد.

Export 1-6-15 تعريف ناحيه

به منظور تعريف و صادر كردن کي ناحيه Export درون سند مراحل بعد را انجام دهيد:
کليک نماييد.

 
 Output Area روي ابزار ،Tools 1- از جعبه ابزار

2- ناحيه Export  را به‌وسيله درگ ماوس انتخاب كنيد.
3- گزينه File→Export را انتخاب کنيد.

4- در کادر مح��اوره‌Export Document ، ب��ه منظور Export کردن ناحيه تعريف ش��ده، 
گزينه Area را انتخاب كنيد.

 Export کلي��ک کنيد. در اي��ن لحظه ناحيه خروجي تعريف ش��ده Save 5- روي دکم��ه
مي‌شود.

بعد از تعريف ناحيه Export  مي‌توان اندازه آن را تغيير داد يا آن را حذف نمود.
Export 2-6-15 تغييراندازه، جابه‌جايي و حذف ناحيه

به منظور تغييراندازه ناحيه Export، در حالي که ابزار Output Area  انتخاب ش��ده است، 
اش��ار‌ه‌گر ماوس را در گوش��ه يا روي دس��تگيره کناري ناحيه قرار داده و آن را درگ نماييد 

)شکل 15-11(.
براي حرکت دادن ناحيه Export بايد اشاره‌گر ماوس را روي آن ناحيه قرار دهيد و زماني 
که اش��اره‌گر به شکل دس��ت تغيير شکل پيدا كرد، به س��مت موردنظر عمل درگ را انجام 
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دهيد. 

                 

Export شکل 11-15 تغيير اندازه ناحيه

 نكته: به منظور حذف ناحيه Export کليد Delete  را از صفحه کليد فشار دهيد.

3-6-15 تعريف ناحيه خروجي

به کمک ابزار Output Area مي‌توانيد ناحيه خروجي براي چاپ را نيز تعريف كنيد. ناحيه 
خروجي شامل ناحيه انتخابي در صفحات موجود و نواحي انتخابي در Pasteboard  است.

چاپ ناحيه خروجي 
1- ناحيه مورد نظر از شکل را با ابزار Output Area انتخاب نماييد.

2- دستور File→Print را اجرا کنيد.
3- در کادرمحاوره‌ Print گزينه Area را در حالت انتخاب قرار دهيد.

 4- به‌منظور چاپ ناحيه کل صفحه گزينه Page boundary را در حالت انتخاب قرار دهيد
)شکل 15-12(.

5- روي دکمه Preview کليک كرده و پيش‌نمايش چاپ را مشاهده كنيد.
6- روي دکم��ه OK  در کادر محاوره Print Preview  و ‌س��پس کادر محاوره Print کليک 

نماييد تا   عمل چاپ آغاز شود.
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شکل 12-15چاپ ناحيه خروجي
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واژه‌نامه
Againدوباره، مجدد

Boundaryکرانه، مرز

Color Managementمديريت رنگ

Compositeمرکب

Exportارسال، صادر کردن

Externalخارجي، بيروني

Previewپيش‌نمايش

Separationsتفکيک

Uniformکيسان، متحدالشکل

خلاصه مطالب 
Export:	 اين فرمان به منظور ارس��ال و صادر کردن موضوعات به برنامه‌هاي ديگر يا 

براي چاپ استفاده مي‌شود.
Print:	 با اس��تفاده از اين گزينه مي‌توان تمام يا بخشي از تصوير ترسيمي مورد نظر 

را روي کاغذ چاپ کرد. 
پ��س از صدور کي فايل، در صورتي که  بخواهيد تغييراتي را در س��ند اصلي ايجاد  	 

کنيد و سپس بدون تنظيم کادر محاوره Export مجدداً فايل مزبور را صادر کنيد از 
فرمان File→Export Again استفاده کنيد.

به منظور تنظيم رنگ تصاوير در صفحه نمايش و هنگام چاپ در FreeHand	 مي‌توان 
از Color Management يا مديريت رنگ استفاده كرد.
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آزمون نظري
درستي يا نادرستي گزينه هاي زير را تعيين کنيد.

1- فرمان  Exportبه منظور ارس��ال و صادر کردن موضوعات به برنامه‌هاي ديگر يا براي 
چاپ استفاده مي‌شود.

2- هنگام عمل چاپ گزينه  Current Page فقط ناحيه انتخاب شده را چاپ مي‌کند.
3- هنگام صدور فايل اگر گزينه Page boundary  را انتخاب کنيد، لبه‌هاي صفحه در فايل 

صادر شده نشان داده مي‌شود.
4- از Color Management به منظور مديريت و تفکيک رنگ‌ها استفاده مي‌شود. 

5- هنگام عمل چاپ گزينه  Fit on paper اندازه تصوير را طوري تغيير مي‌دهد که با کاغذ 
مورد نظر متناسب باشد.

معادل گزينه هاي سمت‌ راست را از ستون سمت ‌چپ انتخاب کرده و مقابل هر عبارت بنويسيد.

Keyline          .6- اين گزينه وظيفه تنظيم ويژگي‌هاي چاپ پيشرفته را بر عهده دارد
        All           .7-بدون نمايش رنگ‌ها و زمينه‌ها فقط مسيرهاي طراحي را نشان مي‌دهد

8- اين پيش‌نمايش، کار طراحي را با تمام زمينه‌ها و رنگ‌ها نشان مي‌دهد.
Printer Setup                                                                                        
Output Area        .9-انتخاب اين گزينه سبب چاپ تمام صفحات سند جاري مي‌شود
Preview                   .10- مي‌توان براي تعريف ناحيه چاپ  از اين ابزار استفاده كرد

گزينه صحيح را انتخاب کنيد.

11- کدام فرمان براي صدور فايل‌هاي گرافيکي به برنامه‌هاي ديگر استفاده مي‌شود؟
Export -د 	Import -ج 	Save As -ب 	 Save -الف

12- کدامکي‌ از گزينه‌هاي زير وظيفه فرمان Export است؟ 
الف- ذخيره فايل با فرمتي هم‌ساز با برنامه گرافيکي مقصد 

ب- تبديل فرمت فايل جاري در  FreeHand به فرمت‌هاي گرافيکي ديگر
ج- Export معادل فرمان Save است.

د- گزينه‌هاي الف و ب صحيح هستند.
13- در صورتي که در فايل ارسال شده به نرم‌افزارهاي ديگر، تغييري ايجاد کرده باشيد، 
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کدام فرمان براي صدور تغييرات مناسب است؟
Again Export -ب 	      Export Again -الف

Export Document -د 		  Export As -ج
14- فرمان ............... وظيفه چاپ اسناد گرافيکي را در FreeHand به عهده دارد.

Printer -د 	Output -ج           	Print Range -ب 	 Print -الف
15- ب��راي چ��اپ کي موضوع خاص انتخابي در صفحه توس��ط فرمان Print، کدام مورد 

مناسب است؟ 
Current page -د 		 Area -ج 	Selected Objects -ب 	 All -الف

16- انتخاب گزينه Print to file چه عملي انجام مي‌دهد؟
الف- خروجي فايل گرافيکي را به چاپخانه مي‌فرستد.

ب- خروجي چاپ، به اندازه حداکثر فضاي قابل چاپ صفحه کاغذ خواهد شد.
ج- اطلاعات را به کي چاپگر ديگر غير از چاپگر پيش‌فرض مي‌فرستد.

د- اطلاعات چاپ شده را درون کي فايل ذخيره مي‌کند.
در جاي خالي عبارت مناسب را بنويسيد.

FreeHand -17 فايل‌هاي متني را با فرمت ........... فراخواني مي‌کند.
18- در پيش‌نمايش X-Box، طراحي به صورت ........... نشان داده مي‌شود.

19- براي صدور ناحيه تعريف ش��ده توس��ط ابزار Output Area  واقع در جعبه ابزار 
Tools، بايد گزينه ......... را انتخاب کنيد.

20- انتخاب گزينه ............................ هنگام صدور فايل، باعث مي‌ش��ود که پس از ذخيره 
شدن فايل با فرمت انتخاب شده، بلافاصله برنامه مقصد اجرا شده و فايل ذخيره شده در آن 

نشان داده شود.
به سؤالات زير پاسخ تشريحی دهيد.

21- فرمت‌هاي پشتيباني شده براي صدور فايل در FreeHand را نام ببريد.
22- آيا از طريق فرامين Copy/Paste در FreeHand مي‌توان با فتوش��اپ تبادل اطلاعات 

کرد؟
23- چگونه مي‌توانيد با استفاده از فرمان Print ترسيمات خود را 50% کوچ‌کتر از اندازه 

واقعي چاپ کنيد؟
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آزمون عملي 
1- آرم زير را رسم کنيد.

2- کارت ويزيتي به ابعاد موردنظر و با استفاده از آرم دلخواه براي کي سالن بدن‌سازي طراحي 
 و چاپ کنيد که شامل نام سالن، نام مديريت سالن ورزشي، خدمات ارايه شده، آدرس، شماره تلفن و

E-mail باشد. 

3- براي يك سالن ورزشي سربرگ مناسب طراحي کنيد که شامل نام سالن، آرم )شكل 
س��ؤال 1(، تاريخ، پيوست، آدرس، شماره تلفن وE-mail باشد. همچنين کي تصوير مرتبط با 

موضوع نيز به صورت محو در زمينه سربرگ وجود داشته باشد.
4- سربرگ طراحي شده را به نام My design براي چاپخانه صادر کنيد )به فرمت ارسالي 

توجه کنيد(.
5- در کي کاغذ A4، 2 نسخه از سربرگ را توسط چاپگر، چاپ کنيد. 
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آزمون پاياني )نظري(

1- کدامکي‌ از عبارات زير صحيح است؟
الف- کليک روي  در نوار ابزار اصلي، سند جديد را ايجاد مي‌کند.

ب- نوار اطلاعات )Info( همان نوار ابزار استاندارد است.
ج- برنامه FreeHand 10 بدون سند جديد باز مي‌شود.

د- امکان باز کردن فايل‌هاي قبلي در کادر Wizard ورودي وجود ندارد.
2- در پنل Document گزينه  چه عملي انجام مي‌دهد؟
ب- نمايش دو صفحه‌اي الف- نمايش تک صفحه‌اي   	
د- نمايش حاشيه صفحه ج- نمايش چند صفحه‌اي        	

Define Grids -3  ب��ه منظ��ور ............ و .............. نماي پرس��پکتيو )Perspective(  به‌کار 
مي‌رود.        

الف- نمايش - تغيير جهت                               ب- حذف - غيرفعال شدن 
د- ايجاد - ويرايش  ج- فعال شدن- تعويض                           	

4- هر چقدر ش��عاع گردي گوش��ه‌ها )Corner Radius( در ابزار Rectangle  کمتر باش��د، 
ميزان انحناي گوشه‌هاي چهارگوش ......................... خواهد بود. 

ج- بيشتر             د- تأثيري ندارد. الف- گردتر        ب- کمتر	
5- شکل مقابل توسط کدام ابزار ترسيم مي‌شود؟

		  Pen -الف 	
		               Line  -ب 	

                     Bezigon -ج 	
د- گزينه‌هاي الف ‌و ج صحيح ‌هستند.      	

6- هنگام استفاده از ابزار Polygon و انتخاب گزينه Star اگر عبارت Number of Sides را 
برابر 4 قرار دهيد كدام شكل ترسيم مي‌شود؟

د-   	 	        ج-     ب-
 

الف- 
7- کدامي‌��ک از فرمت‌ه��اي زي��ر، فايل را ب��ا حجم پايي��ن و 16 ميلي��ون رنگ ذخيره 
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مي‌سازد؟
 bmp-د       	 fh10 -ج            jpeg -ب               gif -الف

8- در هنگام طراحي با اس��تفاده از کدام گزينه مي‌توان نماهاي مختلف ديد را تعريف و 
ذخيره کرد؟

	magnification -ب 		  custom -الف

د- با استفاده از نواروضعيت  		    zoom-ج

9- اگر در هنگام رسم خط، کليدShift  را نگه‌داريد، خط چگونه رسم مي‌شود؟
الف- در زواياي 45 درجه و صاف 	

ب- نرم و عمودي
ج- از مرکز و بدون زاويه  	

د- به‌صورت منحني 
Text Rulers-10  چه امکاني را ايجاد مي‌کند؟

الف- سبب نمايش خط‌هاي راهنما روي صفحه خواهد شد.
ب- براي ترسيم دقيق اشکال به‌کار مي‌رود.

ج- در زمان تايپ، خط‌کش کوچکي در بالاي متن ظاهر مي‌کند.
د- همان Page Ruler است.

11- اگر دس��تگيره‌هاي وس��طي سمت چپ و راس��ت متن بلوک ش��ده را درگ کنيد، 
مي‌توانيد:

ب- سايز قلم را بزرگ کنيد. الف- متن را بچرخانيد.                 	
د- فاصله بين حروف را تغيير دهيد. ج- سايز حروف را کاهش دهيد.       	

12- در متن زير کدام Effect  به‌کار رفته است؟

Shadow -ب 		  Highlight -الف
    Inline -د            		   Zoom -ج

13- براي وارد كردنStyle هاي آماده قبلي بايد گزينه ........... را انتخاب کنيد.
   Export-ب 		   Edit  -الف
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  Redefine -د 		   Import-ج
14- کليک روي دکمه  در نوار ابزار Text چه عملي را انجام مي‌دهد؟

الف- متن را روي مسير مورد نظر قرار مي‌دهد.
ب- مسير را روي متن مورد نظر قرار مي‌دهد.

ج- متن را از مسير جدا مي‌سازد.	
د- متن داخل شکل موردنظر قرار مي‌گيرد.

15- توس��ط کدام ‌گزينهConvert Case  کلمه‌ س��مت چپ به کلمه س��مت‌ راست تبديل 
مي‌شود؟

       EXAMINATION             	Examination

 lower -ب           		  upper -الف
small caps -د            		  title -ج

 Select 16- به‌منظ��ور انتخاب‌ کليه موضوعات طراحي‌ش��ده در کل ‌س��ند از کدام گزينه
مي‌توان استفاده کرد؟

  Super Select-ب 	            	 All -الف
    All in Document-د 	      Pointerج- با استفاده از

17- توسط چه گزينه‌اي از پنلTransform  مي‌توان شکل 1 را به 2 تغيير داد؟

           

Copy و Rotate  -د           Skew -ج               Rotate -ب     Copy و Scale -الف
18- براي ساخت اشکال خميده از ابزار ...................... استفاده مي‌شود.

 Fill  -د         	Knife -ج               Trace -ب               Freeform-الف
19- براي تبديل شکل 1 به 2 کدام ابزار به کار رفته است؟
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  Object -د            	Scale -ج                 Rotate -ب           Reflect -الف
20- به منظور برش خط صاف کدام گزينه از ابزار Knife به کار مي‌رود؟

 Freehand-د           	 Straight -ج           	Length -ب        	Tight fit -الف
21- کدام گزينه در مورد پنل Object صحيح است؟

الف- مشخصات موضوع ترسيمي را نشان مي‌دهد.
ب- تنظيمات و مشخصات پنل Object  بستگي به موضوع انتخابي ندارد.

ج- گزينه‌هاي داخل Panel  فقط زماني فعال مي‌شوند که شکل با ابزارRectangle  ترسيم 
شود.

د- براي تغيير رنگ شكل رسم شده مورد استفاده قرار مي‌گيرد.
22- در کدامکي‌ از پنل‌ها مي‌توان رنگ‌هاي جديدي را از ترکيب رنگ‌ها ايجاد کرد؟

 Export Color-د 	    Swatches -ج     Color Mixer-ب 	Replace Color -الف
23- توسط کدام گزينه شکل 2 و شكل 1 به‌وجود مي‌آيد؟

   Pattern-د 	Text     -ج 	Fill  -ب   	  Stroke -الف
24- براي تکرار کي طرح در داخل کي شکل از کدام گزينه زير استفاده مي‌شود؟

  Texture -د 		  None-ج            Tiled -ب               Basic -الف
25- انتخابJoin  به صورت   در پنل Object چه عملي را انجام مي‌دهد؟

الف- نوع گره را در انتهاي مسير مشخص مي‌کند.
ب- گوشه‌هاي دو خط کي مسير را پخ مي‌کند.
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ج- گوشه‌هاي دو خط کي مسير را گرد مي‌کند.
د- گوشه‌هاي دو خط کي مسير را نوک تيز مي‌کند.

26- براي نگهداري رنگ‌هاي ايجاد شده از گزينه .................. استفاده مي‌شود.
Color -ب 		              Tint-الف

 Color Mixer -د 	            	  Swatches-ج
27- پنلTransform  کدامکي‌ از اعمال زير را کنترل مي‌کند؟

ب- تغيير جهت، اندازه و چرخش تصوير       الف- نکات مربوط به نوشته‌ها در تصوير  	
ج- تغيير بزرگنمايي تصوير	            د- تغيير رنگ‌هاي تصوير

28- براي تبديل کي خط باز به کي پيکان از کدام گزينه استفاده مي‌شود؟
 Grid-د      	Arrowheads -ج        Cap -ب 	     Color List -الف

29- اگر بخواهيد موضوع انتخاب ش��ده در بزرگ‌ترين حالت ممکن نمايش يابد از کدام 
گزينه استفاده مي‌شود؟

 Custom -د 		 Fit to Page -ج   	 Fit All -ب 	    Fit Selection -الف
30- براي نمايش ....................... بايد خط‌کش )Ruler( روي صفحه ظاهر شود.

 Grid -ب 		  Perspective -الف
    Guides-د            		  Lock -ج

31- با استفاده از گزينه ..................... مي‌توان از چند شکل مجزا کي شکل   واحد  ساخت.
 Lock -د                Join -ج     	   Union-ب        Group-الف

32- براي انتخاب اجزاي کي گروه کدام ابزار به‌کار مي‌رود؟
د- همه‌ گزينه‌ها صحيح هستند.  	 Subselect -ج 	 Pointer -ب  	 Group -الف

33- براي اتصال دو پاره‌خط به کيديگر، پس از انتخاب هردو خط چه بايد کرد؟ 
الف- از فرمان Modify→Join  استفاده شود.

ب- از کليد ميانبر Ctrl+J استفاده شود.
ج- از فرمان Modify→Split  استفاده شود.	

د- از فرمان wtras → Join استفاده شود.
34- براي بريدن و جدا کردن قسمت‌هاي روي هم افتاده مسيرها از کدام فرمان استفاده 

مي‌شود؟
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  Punch -د       	   Crop -ج          Ungroup-ب    	 Split -الف
35- به کمک کدام ابزار مي‌توانيد با استفاده از اشکال گرافيکي از پيش آماده و با حرکت 

دادن  ماوس در صفحه، جلوه گرافيکي جالبي ايجاد کنيد؟ 
 Smudge -د                 Spiral-ج           Arc -ب       Graphic Hose-الف

36- ابزار 3D Rotation  در نوار ابزارXtra چه کاربردي دارد؟
الف- ايجاد عمق در موضوعات با استفاده از سايه

ب- ايجاد دوران سه بعدي در موضوعات 
ج- ايجاد تقعر و تحدب در موضوعات 

د- ايجاد دوران در موضوعات به صورت دو بعدي 
37- براي ترسيم خطوط مارپيچ از چه ابزاري استفاده مي‌شود‌؟

 Bend -د      	 Smudge -ج             Spiral -ب              Arc -الف
38- کدام گزينه صحيح است؟

الف- پنل Align از طريق منوي Window ظاهر مي‌شود.
ب- براي باز کردن پنل Align  مي‌توانيد از کليد تركيبي Ctrl+Alt+A استفاده کنيد.

ج- ازطريق‌پنل Align مي‌توانيد چندين‌موضوع را نس��بت‌به‌هم يا به صفحه در کي راستا 
قرار دهيد.

د- همه گزينه‌ها صحيح هستند.
39- با استفاده از کدام فرمان، شکل 1 به 2 تبديل مي‌شود؟

 Ungroup-د                Intersect-ج          Divide-ب         Transparency -الف
40- براي محدب كردن کي متن کدام مورد زير صحيح است؟

الف- ابتدا دستور Convert to path  و سپس ابزار Fisheye Lens را اجرا كنيد.
ب- براي محدب کردن موضوعات بايد ابزار Arc را براي ايجاد قوس و انحنا به کار برد. 
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 Xtra  Toolsاز نوار ابزار Fisheye Lens ج- انتخاب ابزار
د- چنين امکاني وجود ندارد.

41- براي اصلاح جهت قرارگيري مس��يرها و کاهش تع��داد گره‌ها کدام گزينه از منوي 
Xtras به كار مي‌رود؟

 Clean up -د           Distort -ج           Create -ب    	 Colors -الف
42- نحوه عملکرد ابزار Blend در کدام گزينه زير نشان داده شده است؟

الف-         	ب-    	

ج-      د-         
43- براي تبديل رنگ موضوعات از مدل RGB يا CMYK به مدل خاکستري کدام مورد 

زير صحيح است؟ 
Convert to Grayscale -ب 	                      Darken Colors -الف
         Lighten Colors -د 	               Desaturate Colors-ج
44- فرمان Emboss از گزينه‌هاي فرمان  Create چه کاربردي دارد؟

الف- براي ايجاد جلوه آميختگي بين دو موضوع به كار مي‌رود.
ب- به منظور روي هم افتادن رنگ‌ها در چاپ استفاده مي‌شود.

ج- تعدادي گره به خطوط مسير اضافه مي‌کند.
د- انواع جلوه‌هاي برجسته‌سازي را ايجاد مي‌کند.

45- فرامين موجود در منوي Path Operation چه عملي را انجام مي‌دهند؟
الف- جلوه‌هايي به منظور زيباترکردن کار توليد مي‌کنند.

ب- مسيرهاي انتخاب شده را تغيير شکل مي‌دهند.



Free Hand پیمانه مهارتی : کاربر
455آزمون پایانی

ج- عملکرد فرامين آن مانند گزينه‌هاي منوي Modify است.
د- بعضي از خصوصيات غيرضروري موضوعات را حذف مي‌کند.

46-  با استفاده از کدام فرمان، شکل 2 از شکل 1 به‌وجود مي‌آيد؟
Roughen -الف

                                                          Bend-ب
 Distort -ج

                          Simplify -د
47- کدامکي‌ از موارد زير جزء انواع سايه در ابزار Shadow نيست؟

 Soft Edge -د               Zoom -ج             Trap -ب 	     Hard Edge -الف
48-براي‌صدورفايل‌ايجاد‌شده در FreeHand   به‌نرم‌افزارهاي‌ديگر‌از‌چه‌فرماني اس��تفاده‌ 

مي‌شود؟
Export -د    	  Import -ج          Open -ب          	 Save -الف

49- براي تعيين مشخصات چاپ از قبيل سايز، نوع کاغذ و کيفيت چاپ از کدام قسمت 
كادر محاوره Print  استفاده مي‌شود؟

  Color Management -ب 		 Properties -الف
   Scale -د 	          Print Range -ج

50- براي تبديل موضوعات برداري به طرح بيتي از دستور .................. استفاده مي‌شود.
                                      Output options -د            Rasterize -ج      Extract -ب        Links -الف 

به سؤالات زير پاسخ تشريحي دهيد.

     1- تفاوت دستور Import  وOpen  در FreeHand چيست؟
2- ي��ک روش براي اضافه کردن نقاط گره‌اي به مس��يرها و ي��ک روش براي کم کردن 

گره‌ها نام ببريد؟
3- اب��زار ................. براي ايجاد نمودارهاي گرافيکي و گزينه .............. براي ش��فاف كردن 

رنگ قسمت‌هاي مشترک بهك‌ار مي‌روند.
4- عملکرد گزينه‌ها و کليدهاي زير را بنويسيد؟

 Ctrl+R -د 	           Ctrl+L -ج         	Crop -ب              Split -الف
5- گزينه Snap to Grid چه عملي را انجام مي‌دهد؟
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6- ابزارZoom  مشابه با کدام گزينه يا ابزار عمل مي‌کند؟                                            
7- تفاوت ابزارPen  و Bezigon در چيست؟	

8- در هنگام کار با متن براي رنگ کردن دور متن از کدام ابزار استفاده مي‌شود؟
9- دو روش را براي انتخاب موضوعات در کي صفحه بنويسيد؟

10- معادل کليدي و دستوري موارد زير را بنويسيد.
       Text→Attach to Path-ب           	 Edit→Select→All-الف

 Ctrl+F2 -د 		           Ctrl+T  -ج
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آزمون پاياني )عملي(

سري الف
1- الف( فايلي به نام Student بسازيد که حاوي 2 صفحه افقي و 2 صفحه عمودي با واحد 

ميلي‌متر و به ابعاد A4  باشد، سپس نماي ديد را دو برابر نماي فعلي قرار دهيد.
ب( تعدادUndo ها را به 16 افزايش دهيد.

 18x30 2- ش��کل زير را ترس��يم کنيد و سپس آن را طرح کي کاغذ کادو به ابعاد کاغذ
قرار دهيد. 

3- شکل زير را رسم کنيد.

4- رنگ‌هاي )M = 50 ،Y =80 ،K =0 و C =65( و )G =80 ،B =50 و R = 10( را ايجاد 
کنيد، سپس آن‌ها را به Swatches منتقل کرده و با نام‌هاي Rang1 و Rang2 ذخيره کنيد

رنگ خطوط شکل سؤال 3 را كه به رنگ CMYK است، رنگ‌آميزي کنيد.
سري ب

سربرگي با مشخصات زير براي يک مؤسسه طراحي کنيد:

1- ابعاد سربرگ30×15 سانتي‌متر باشد. 	
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					    2- از آرم زير در سربرگ استفاده شود.

3- با رعايت نکات صفحه‌آرايي، آرم ‌را در محل مناس��ب قرار داده و نام مؤسس��ه، شماره 
نامه، تاريخ، پيوست، آدرس و تلفن را در سربرگ بنويسيد.

4- آرم را به Photoshop ارس��ال کرده و براي زيبايي کار، روي آن فيلتر مناس��بي اعمال 
کنيد، سپس آن را به فايل خود وارد کرده و در زمينه سربرگ استفاده کنيد.
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پاسخنامه

آزمون نظري واحد كار 2

1- غلط                   2- صحيح                      3- صحيح	
Welcome -6                       Setup -5                   4- غلط

	Screen-based -9                Publication -8           Stationery -7
10- د(گزینه های ب و ج صحیح هستند        11- ب( Setup.exe         12- ج( 100	

Online 14- ب( مرور سرفصل‌ها و درس‌هاي برنامه به صورت   Previous File )13- ج
17- افزايش - کاهش 	            Wizard-16 	Template -15

آزمون نظري واحد كار 3

2- غلط	           3- صحيح 1- صحيح	
Revert -6 	Zoom -5 	Import -4

Customize  Toolbar -7
10- ج( منوي Unit در نوار ابزار Info قرار دارد. 	Info 9- ب( نوار 8- د( حذف	

11- ب( تايپ 130% در منوي  Magnification از نواروضعيت
Keyline )13- ج 	Preferences )12- الف

14- ب( اگر چندين صفحه گرافيکي داش��ته باش��يد همه صفحات را در محيط نش��ان 
مي‌دهد.

15- ج( کليه تغييرات در ترسيم به آخرين مرحله ذخيره سازي برمي‌گردد.
Keyboard Shortcuts -18 	TIF )17- د           	FH11)16- ب

Text 20- زبانه 	Save As -19
آزمون نظري واحد كار 4

2- غلط             	3- غلط	 1- صحيح	
Release -6 	Library -5 	Bleed -4

Snap Distance -7
8- د( همه‌ گزينه‌ها صحيح هستند.

9- الف( تغيير اندازه صفحه بر اندازه موضوع ترسيمي تأثير مي‌گذارد.
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Alt )11- د 		 Custom )10- ج
12- د( رنگ و تعداد خطوط شبکه سه بعدي را نمي‌توان تغيير داد.

Duplicate )13- ج
14- ب( براي استفاده ازMaster Page هاي ايجاد شده در سندهاي ديگرِ FreeHand آن‌ها 

را Export مي‌کنند.
	Release -16 	View→Snap to Object )15- ب

17- جابه‌جايي صفحه
آزمون نظري واحد كار5

2- غلط             3- صحيح 1- صحيح	
Star -6 	Rectangle -5 4- غلط	

Pen -8	           9- ب( رسم دايره و بيضي 	Line -7
Polygon )11- ج 	  Alt)10- د

12- ب( تعداد اضلاع چندضلعي را مشخص مي‌کند.
Shift )14- ج           	Line )13- الف

15- ج( در ص��ورت فع��ال بودن ابزار Pen هنگامي ک��ه روي صفحه کليک مي‌کنيم کي 
16- امکان بالا بردن دقت کار	 نقطه گوشه به ‌وجود مي‌آيد.	
Shift -17	  Alt -18          19- رسم خط صاف يا منحني

آزمون نظري واحد كار 6

2- غلط	           3- غلط 1- صحيح	
	Pointer -6 	Knife -5 4- صحيح	

Freeform -8 	Alt -7
9- ب( رسم مارپيچ    10- د( رسم کمان    11- د( گزینه های ب و ج صحیح هستند

12- ج( برش زدن تصاوير	
13- د( همه گزینه ها صحیح هستند

Clone)15- ج 		 Straight )14- ب
Subselect -16	                     17- چندين موضوع را باهم درحالت انتخاب قرارداد.

Alt -19 18- اتصال اشکال به کيديگر	
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آزمون نظري واحد كار 7 

3- صحيح 2- غلط  	 1- صحيح	
Remove -6 	Duplicate -5 4- غلط	

Saturate Colors )8- ب 	Replace -7
WebSafe 216  )10- د             	Darken Colors  )9- ب

HLS  )13- ج 	Alt  )12- ب 	 11- د( 
	CMYK -15 	Show /Hide names  )14- ج

	Name All Colors -17            		 16- کاهشي
18- 360+% تا 360-%	            19- تک رنگ و دورنگ

آزمون نظري واحد كار 8

3- صحيح 2- صحيح	 1- غلط	
6- شيب تابعي 5- شيب کروي	 4- غلط	
Pattern )9- د 	 Trap -8 	Fractalize -7

11- د( گزينه‌هاي الف و ج صحيح هستند.	 	           Gradient )10- ب
	   Eye Dropper)13- الف 12- ج( تعيين وضعيت انتهاي خطوط	

Blend -16 	Stroke -15 14- د( مخروطي	
Ctrl+Shift+B -18                  17-جلوه‌هاي برجسته‌سازي

آزمون نظري واحد كار 9

3- صحيح 2- صحيح	 1- غلط	
Remove Transform -6 	Text Editor -5 4- غلط	

 Flow Around Selection -8 	Attach To Path -7
9- ب( در روي متن خط رسم مي‌کند.

Text از منوي Attach To Path )11- ب 10- ج( ايجاد سبک قلم نازک و معمولي	
Shadow )13- د              	Text→Leading→Other )12- الف

14- د( گزينه‌هاي الف و ب صحيح هستند.
15- ج( تبديل حروف کوچک و بزرگ به کيديگر در متون انگليسي
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16- ب( حرف اول همه كلمات متن انتخابي را بزرگ و بقيه را کوچک مي‌کند.
19- متن را به موضوع ترسيمي 	Percentage -18 	Sentence )17- ب

آزمون نظري واحد كار 10

3- غلط	 2- صحيح	 1- غلط	
Punch -6 	Intersect -5 4- غلط	

Reverse Direction -8 	Crop -7
Remove Overlap  )10- ب 	Join )9- الف

	Unlock )13- ج 	Union )12- ج 	Align )11- الف
Expand Stroke )15- ب           	Join )14- د

	Inset Path -18 	Subselect )17- ب 	Divide )16- الف
Skew -20 	Horizontal -19

آزمون نظري واحد كار 11

2- صحيح	  3- صحيح 1- غلط	
	Bend -6              	Blur -5 4- غلط	

	Rotate from )9- ج  	Emboss -8 	Bevel -7
Bend  )11- ب             	Fisheye Lens   )10- ج

Paste as envelope )13- د              Transparency )12- ب
Sketch -16 	Ragged -15 	Expand Path -14

آزمون نظري واحد كار 12

3- صحيح 2- صحيح	 1- غلط	
6- غلط 5- صحيح	 4- صحيح	

Unlock -Visible -8 	Active -7
Remove Unused -11       Remove -10       Edit -9

Duplicate  )13- ب 	Decimal Precision )12- ج
15- ج(   	Merge Foreground Layers  )14- الف

	Guides -17           	Large List View )16- الف
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19- والد يا اصلي	        20- والد )اصلي( - فرزند 	Auto-Update -18
آزمون نظري واحد كار 13

3- صحيح 2- غلط   	 1- صحيح	
Fireworks -6 	Import -5 4- غلط	

	Jpeg )9- ج           	GIF -8 	Lossy -7
	Always Use Source PNG )10- الف

Trace )12- د 11- ج( تغيير اندازه و تغيير فرمت فايل	
13- ب( ميزان شباهت مسيرهاي Trace شده به مدل اوليه را تعيين ميك‌ند.

Convert to Image -14	               15- نرمي لبه‌هاي دور تصوير
Update -17 		 Alt -16

آزمون نظري واحد كار 14

3- صحيح 2- غلط  	 1- صحيح	
Action -6 5- صحيح	 4- غلط	

Link to Target Page -8 	Target Page -7
 The Full Screen action )10- د 	Release to Layers -9

13- ج( تست و اجراي فيلم	 	GIF  )12- ب 	Trail  )11- الف
Publish as HTML -14	           15- بازيابي يا بارگذاري - عدم بازيابي

آزمون نظري واحد كار 15

2- غلط	            3- صحيح 1- صحيح	
 Printer setup -6 5- صحيح	 4- صحيح	

	All -9 	Preview -8 	Keyline -7
	Export )11- د 	Output -10

Export Again )13- الف 12- گزینه های الف و ب صحیح هستند 	
Selected Objects  )15- ب                       	   Print )14- الف

16- د( اطلاعات چاپ شده را درون کي فايل ذخيره مي‌کند.	
	  RTF, ASCII-17

Open in external application -20 	area -19 18- علامت ×  	
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ضميمه الف
تمرينات كاربردي

1- تصاويرکتاب‌کود‌کرا که در شکل 1- الف‏، 2- الف و 3- الف نشان داده شده، ترسيم 
کنيد.

    

شكل 1- الف

شكل 2- الف
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شكل 3- الف

2- جلد کتاب با مشخصات زير را طراحي کنيد.
الف( آموزش درس زبان انگليسي باشد.
ب( مربوط به پايه دوم دبيرستان باشد.

ج( سال چاپ و قيمت روي آن مشخص باشد.
3- کارت ويزيت مربوط به يك ش��ركت گرافيكي كه در زمينه كار تبليغاتي فعاليت دارد 

را ترسيم کنيد.
4- يك سربرگ براي كلينيك تخصصي چشم پزشكي طراحي كنيد.

5- يك پوستر در ابعاد مناسب طراحي کنيد كه موضوع آن اصلاح الگوي مصرف باشد.
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6- تصوير زير را رسم کنيد.

شكل 4- الف

7- يك جعبه دستمال كاغذي را طراحي كنيد )از دستور Import براي استفاده از تصاوير 
استفاده كنيد(.

8- آرم‌هاي زير را طراحي کنيد.

  

شكل 5- الف
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9- پشت و روي ساک دستي مربوط به يك فروشگاه كيف و كفش را طراحي کنيد.
10- کاغذ کادويي را ترسيم کنيد كه مناسب براي كادوي تولد يك كودك باشد.

11- براي شعر زير تصوير‌سازي کنيد.
» اي شاپرک! تن تو

ُپر موج، مثل آب است
آن بال کاغذينت 

				   مانند کي کتاب است
در آن کتاب رنگی

عکس بهار پيداست
هم کوه و باغ و صحرا 

هم جويبار پيداست
کار تو، صبح تا شب

گشتن ميان باغ است
در اين بهار زيبا

بازار تو چه داغ است!
اي شاپرک بيا، باز

 واکن کتاب خود را

در انتظار هستند

گل‌هاي خانه ما.” 
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ضميمه ب
MX FreeHand ميانبرهاي صفحه كليد در برنامه

File منوي

معادل كليديگزينه

NewCtrl+N

OpenCtrl+O

Close‍‍Ctrl+W

SaveCtrl+S

Save AsCtrl+Shift+S

ImportCtrl+R

ExportCtrl+Shift+R

PrintCtrl+P

QuitCtrl+Q

Edit منوي

UndoCtrl+Z

RedoCtrl+Y

CutCtrl+X

CopyCtrl+C

PasteCtrl+V

Special: Paste AttributesCtrl+Alt+Shift+V

Cut ContentsCtrl+Shift+X

Paste InsideCtrl+Shift+V

Duplicate Ctrl+Alt+D

CloneCtrl+Shift+D

Select:AllCtrl+A

Select All In DocumentCtrl+Shift+A

Select:NoneCtrl+D
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Find And ReplaceCtrl+F

PreferencesCtrl+U

  View منوي

Fit SelectionCtrl+Alt+ 0

Fit To PageCtrl+Shift+W

Fit AllCtrl+0

Magnification :%50Ctrl+5

Magnification :%100Ctrl+1

Magnification :%200Ctrl+2

Magnification : %400Ctrl+4

Magnification : %800Ctrl+8

KeylineCtrl+K

Fast ModeCtrl+Shift+K

ToolbarsCtrl+Alt+T

PanelsF4,Ctrl+Shift+H

Page Rulers:ShowCtrl+Alt+R

Text Rulers Ctrl+/

Guides:ShowCtrl+;

Guides: LockCtrl+Alt+;

Guides:Snap To GuidesCtrl+Shift+;

Grid: ShowCtrl+Alt+G

Grid:Snap To GridCtrl+Alt+Shift+G

Snap To PointCtrl+ '

Modify منوي

Transform:Scale…Ctrl+ F10

Transform AgainCtrl+,

 Arrange:Bring To FrontCtrl+Shift+Up Arrow
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Arrange:Move ForwardCtrl+Up Arrow

 Arrange:Move BackwardCtrl+Down Arrow

 Arrange:Send To BackCtrl+Shift+Down Arrow

Align:TopCtrl+Alt+ 4

Align:BottomCtrl+Alt+ 6

Align:Center HorizontalCtrl+Alt+ 5

Align:Center VerticalCtrl+Alt+ 2

Align:LeftCtrl+Alt+ 1

Align:RightCtrl+Alt+ 3

Align AgainCtrl+Alt+Shift+A

JoinCtrl+J

SplitCtrl+Shift+J

Combine:BlendCtrl+Shift+B

Combine:Join Blend To PathCtrl+Alt+Shift+B

LockCtrl+L

UnlockCtrl+Shift+L

GroupCtrl+G

UngroupCtrl+Shift+G

Symbol:Edit SymbolCtrl+ E

Symbol:Convert To SymbolF8

Convert to ImageCtrl+Alt+Shift+Z

Text منوي

Size:SmallerCtrl+Shift+ ,

Size:LargerCtrl+Shift+ .

Font Style: BoldCtrl+B

Font Style: ItalicCtrl+I

Font Style: BoldItalicCtrl+Alt+Shift+O
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Effect:HighlightCtrl+Alt+Shift+H

Effect:StrikethroughCtrl+Alt+Shift+S

Effect:UnderlineCtrl+Alt+Shift+U

Align:LeftCtrl+Alt+Shift+L

Align:RightCtrl+Alt+Shift+R

Align:CenterCtrl+Alt+Shift+C

Align:JustifyCtrl+Alt+Shift+J

Special Character:Em SpaceCtrl+Shift+M

Special Character:En SpaceCtrl+Shift+N

Special Character:Thin SpaceCtrl+Shift+T

Special Character:Discretionary HyphenCtrl+ -

EditorCtrl+Shift+E

Flow Around SelectionCtrl+Alt+W

Flow Inside PathCtrl+Shift+U

Attach To PathCtrl+Shift+P

Xtras منوي

RepeatCtrl+Shift+ =

Window منوي

New WindowCtrl+Alt+N

ToolsCtrl+F2

ObjectCtrl+F3

AnswersCtrl+Alt+F1

LayersF2,Ctrl+ 6

SwatchesCtrl+F9

Styles Shift+F11, Ctrl+ 3

LibraryF11

Color MixerShift+F9, Ctrl+Shift+C
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HalftonesCtrl+H

AlignCtrl+Alt+A

TransformCtrl+M

Movie:TestCtrl+Return

Movie: SettingsCtrl+Shift+Return
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